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How to Use Help

ProShare Personal Conferencing is a program that presents a shared workspace or "notebook" on two 
connected personal computers.    While talking over the phone, you and a colleague at a different 
location can simultaneously view, mark up, and update the same documents in the ProShare 
application's notebook.    You also can share an application and its data with your colleague.
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Basics

Basic topics provide an overview of the ProShare application, the most common tasks, and step-by-
step information for completing the tasks, including jumps into the dialog boxes you use.    You cannot 
access these topics directly from the ProShare application via Help buttons or pressing F1.

Introduction to the ProShare application

ProShare application's main window

Application sharing windows

Moving around in the notebook

Making annotations in the notebook

Setting your notebook preferences

Working in the private workspace

____________
See also

How to...







How to...

How-to topics provide an overview of common tasks and step-by-step information for completing the 
tasks, including jumps into the dialog boxes you use.    You cannot access these topics directly from the 
ProShare application via Help buttons or pressing F1.

Bringing information into the notebook

Connecting to another participant and starting a conference

Embedding OLE data from another application

Importing all or part of a file

Improving performance

Setting up the print capture driver

Setting your connection preferences for incoming connections

Sharing an application

Transferring files

Uninstalling the ProShare software

Using special conferencing features

Working with someone who doesn't have the ProShare application

____________
See also

Basics







 Menu commands

Menu command topics provide short descriptions of menu commands and a jump into the 
corresponding dialog box, if any.    These topics are accessed directly from the ProShare application 
when the command is selected and you press F1.

File menu

New

Open

Import

Save

Save As

Print

Print Setup

Transfer

Transfer Status

n filename, for example, 1 TUTORIAL.MTG

Exit

Edit menu

Cannot Undo or Undo Delete Annotation or Undo Delete Page

Cut

Copy

Paste
Public
Private

Paste Special

Delete

Resize

Add Page
Public
Private

Delete Page
Public
Private

Synchronize Pages

Object or application-name   Object  , for example, Paintbrush Picture Object

View menu

Data Tools

Annotation Tools

Page Sorter

Full Screen

Private Workspace

Preferences



Toolbox menu

Selection Pointer

Remote Pointer

n annotation-tool, for example, 1 Black Text

Configure Tool   n   or Configure Remote Pointer

Conference menu

Connect

Disconnect

Address Book

Setup

Jump Start

Application menu

Share Application View

Host and Guest Edit

Only Host Edits

Stop Sharing Application

Help menu

Contents

Search for Help On

How to Use Help

Tutorial

About

Data Capture pop-up menu (when you use the camera or crop tool)

New Page

Current Page

New Private Page

Current Private Page

Quit Snapshot







 Dialog boxes

Dialog box topics provide detailed information on how to use the dialog boxes and what each control is 
for.    These topics are accessed directly from the ProShare application when the dialog box is displayed 
and you choose the Help button or press F1.

The following list is in alphabetical order.    If you want to use the >> and << browse buttons to view all 
the dialog boxes, start with the Open dialog box.

Add Participant Name

Conference Setup

Configure Tool or Configure Remote Pointer

Connect

Edit Participant Name

File Transfer

File Transfer Receipt

File Transfer Status

Import

Import Using

Jump Start

Modem Connection Details

Names

NetWare Search

Network Connection Details

Open

Page Sorter

Paste Special

Preferences

Print

Print Setup

Resize Annotation

Save As

Set Modem

Share Application View

____________
See also

ProShare application's main window

Application sharing windows





Shortcuts

Shortcut topics provide descriptions of the ProShare software tools (buttons) plus lots of keyboard and 
mouse techniques to make you more proficient with the software.    You cannot access these topics 
directly from the ProShare application via Help buttons or pressing F1.

Annotation toolbox

Data Capture toolbox

Mouse hotspots

Keyboard shortcuts

Navigation and editing keys



 Annotation toolbox

All tools in the Annotation toolbox have equivalent Toolbox menu commands.    Click on a tool or its 
related command for more information:

Selection Pointer command (Toolbox menu)

Remote Pointer command (Toolbox menu).    You can change the color of the remote pointer 
using the Configure Remote Pointer command from the Toolbox menu:

All of the annotation tools are configurable using the Configure Tool command from the Toolbox menu. 
Any of the six lower buttons in the toolbox can be set to be any of these tools:

Highlighter command (Toolbox menu)

Pen command (Toolbox menu)

Text command (Toolbox menu)

Rectangle command (Toolbox menu)

Ellipse command (Toolbox menu)

Line command (Toolbox menu)







 Data Capture toolbox

The top three tools in the Data Capture toolbox have no equivalent menu commands:

When you use the snapshot tool, the cursor becomes a camera.    As you move the camera 
around the screen, the window under the cursor is highlighted with diagonal lines.    When the desired 
window is highlighted, click the mouse again to take the snapshot.    From the pop-up menu, pick a 
destination in the notebook for the snapshot.

When you use the crop tool, the cursor becomes crosshairs.    Crop the area of the screen you 
want to snapshot by clicking and dragging the mouse diagonally from one corner to the other, then 
releasing the mouse, or by clicking in one corner of the area and then clicking in the opposite diagonal 
corner.      From the pop-up menu, pick a destination in the notebook for the snapshot.

When you use the return tool, the notebook is brought to the top of your screen.

The bottom three tools in the Data Capture toolbox have equivalent Application menu commands.    
Click on a tool or its related command for more information:

Share Application View command (Application menu).

Host and Guest Edit command or Only Host Edits command (Application menu).

Stop Sharing Application command (Application menu).

____________
Tip

When you are not connected to another participant, on color monitors the Share Application View and 
Stop Sharing buttons are gray to indicate the action is unavailable.    Shift+F1 context-sensitive Help is 
not available for the button when its action is unavailable.





 Mouse hotspots

Single-clicking

Single-click a tool in the Annotation toolbox to select it.    Single-click a tool in the Data Capture toolbox 
to cause its action to occur.

Single-click a tab on the right of the notebook to display that page.    Single-click the scroll up and scroll 
down arrows above and below the tabs to scroll hidden tabs into view.

Single-click the New Page tab  to add a new page to the notebook.

Dragging

As you move the mouse cursor over the bottom of the public workspace page, the cursor changes to 

vertical split bars .    Drag the cursor to open and size the private workspace.
In the Page Sorter dialog box, you can drag a page left or right to reposition it in the notebook.    You also 
can drag a page to the Print or Delete buttons.

When an annotation is selected, handles  appear around its border.    Drag one of the handles 
to stretch or shrink the annotation in that direction.    For straight lines, drag either end handle to stretch or 
collapse the line or change its direction.

____________
Important tip

For annotations other than rectangles, ellipses, and straight lines, use Shift+drag to resize the 
annotation and retain its proportions (aspect ratio).    When you use Shift+drag on a rectangle or ellipse, 
it changes to a square or circle, respectively.    When you use Shift+drag on a straight line, it constrains 
the line to horizontal, vertical, or 45-degree angles.

Double-clicking

Double-click an annotation tool in the Annotation toolbox to open the Configure Tool dialog box and 
configure that tool.

Double-click an existing text annotation to edit it.

Double-click a page thumbnail in the Page Sorter dialog box to jump to that page in the notebook.    To 
open the Page Sorter dialog box, from the View menu, choose the Page Sorter command.

Double-click a tab on the right of the notebook to synchronize pages with the other participant (that is, 
move both you and the other participant to that page).

Double-click the page number of the other participant in the Attendee Status bar to jump to that same 
page.



As you move the mouse cursor over the bottom of the notebook page, the cursor changes to vertical split 

bars .    Double-click this cursor to open the private workspace if it is closed, or to close the private 
workspace if it is open.

____________
Tip

When the Annotation toolbox is floating (Float Annotation Tools is selected in the Preferences dialog 
box), double-click anywhere on the page to move the toolbox to that spot, with the following exceptions:

· If the current tool is the selection pointer and you double-click on an OLE annotation, the toolbox 
does not move.    (The OLE annotation is opened in its native application.)

· If the current tool is the selection pointer and you double-click on a text annotation, the toolbox 
does not move.    (The text insertion cursor is placed in the text annotation.)

· If the current tool is the text tool and you double-click on a text annotation, the text insertion cursor 
is placed in the text annotation and the toolbox is placed over the top of the annotation.

· If the current tool is a marking tool and the interface detected a dragging movement with your first 
click, a small annotation is placed on the notebook and the toolbox does not move.    (Sometimes 
the annotation is too small to see.)

Shift-clicking and Ctrl-clicking

Use Shift+Click to select multiple annotations.

In the File Transfer dialog box, use Shift+Click to select multiple consecutive files, or Ctrl+Click to select 
multiple non-consecutive files.

In the Page Sorter, either select each page by using Ctrl+Click, or select a range of pages by using 
Shift+Click to specify both the starting page and the ending page.



 Keyboard shortcuts

Key Description

Alt+F2 Import command (File menu)

Alt+F4 Exit command (File menu)

Alt+Ins Add Page - Public command (Edit menu)

Ctrl+  n  (n is 1, 2, 3, 4, 5, or 6) annotation tool command (Toolbox menu)

Ctrl+F8 Remote Pointer command (Toolbox menu)

Ctrl+A Save As command (File menu)

Ctrl+C Copy command (Edit menu)

Ctrl+D Disconnect command (Conference menu)

Ctrl+F Transfer Status command (File menu)

Ctrl+N New command (File menu)

Ctrl+O Open command (File menu)

Ctrl+P Print command (File menu)

Ctrl+S Save command (File menu)

Ctrl+T Transfer command (File menu)

Ctrl+V Paste - Public command (Edit menu)

Ctrl+X Cut command (Edit menu)

Ctrl+Z Undo Delete Annotation or Undo Delete Page command (Edit menu)

Del Delete command (Edit menu)

Esc Full Screen command (when in full-screen mode)

Esc Quit Snapshot command (Data Capture pop-up menu)

F1 Contents command (Help menu)

F2 Data Tools command (View menu)

F3 Configure Tool   n   command  

F5 Annotation Tools command (View menu)

F7 Full Screen command (View menu)

F8 Selection Pointer command (Toolbox menu)

F9 Synchronize Pages command (Edit menu)

____________
See also

Navigation and editing keys







 Navigation and editing keys

Although the information in the on-line Help describes mouse navigation and editing techniques, you 
can use the keyboard to perform most tasks:

Key Description

Esc Exits full screen mode.    Cancels 
menus and dialog boxes.    Deselects 
an annotation.

Del Deletes a selected annotation.

Tab or
Shift+Tab

Selects the next or previous annotation.

Arrow keys Scrolls the current page in the direction 
of the arrow key.

In a text annotation, moves the cursor 
within the text in the direction of the 
arrow.

Ctrl+Up arrow or
Ctrl+Down arrow

Scrolls the current page up or down by 
half a screen.

Ctrl+Left arrow or
Ctrl+Right arrow

Scrolls the current page left or right by 
half a screen.

In a text annotation, Ctrl+Up arrow and 
Ctrl+Down arrow are the same as Up 
arrow and Down arrow.

PgUp or
PgDn

Scrolls the current page up or down.

Ctrl+PgUp or
Ctrl+PgDn

Moves to the previous or next page in 
the public workspace.

Shift+Ctrl+PgUp 
or
Shift+Ctrl+PgDn

Moves both participants to the previous 
or next page in the public workspace.

Alt+PgUp or
Alt+PgDn

Moves to the previous or next page in 
the private workspace.

Home or
End

Scrolls to the top left or bottom right of 
the current page.

In a text annotation, moves the cursor 
to the beginning or end of the current 
line in the text annotation.



Ctrl+Home or
Ctrl+End

Moves to the first or last page in the 
public workspace.

In a text annotation, moves the cursor 
to the top left or bottom right of the text 
annotation.

Shift+Ctrl+Home 
or
Shift+Ctrl+End

Moves both participants to the first or 
last page in the public workspace.

Alt+Home or
Alt+End

Moves to the first or last page in the 
private workspace.

Ctrl+Alt+F Toggles the guest's sharing window 
between full screen and normal size

Ctrl+Alt+R Redraws the guest's sharing window.

____________
See also

Keyboard shortcuts





Reference information

Reference topics provide supplementary information.    You cannot access these topics directly from the 
ProShare application via Help buttons or pressing F1.

Terms

Troubleshooting



 Troubleshooting

For the latest information, check the Read Me file.    Double-click the Read Me icon in the ProShare 
software program group.

For troubleshooting low memory and other performance issues, see the following topic:

Improving performance

If you cannot connect with the other computer:

· Make sure your colleague has started the 1.6 version of the ProShare software on his or her 
computer.    This version (1.6) of the ProShare Personal Conferencing software cannot connect with 
version 1.5 because the connection methods have changed.    (However, you can open a file saved 
from the 1.5 software and the 1.6 software automatically converts it to the 1.6 format.)

· Use the Communications Test program to test your modem or your computer's access to the 
network.    If you are using a modem, make sure you have the correct COM port for your modem 
selected in the Conference Setup dialog box and the correct number for your colleague in the 
Modem Connection Details dialog box.

· Make sure your colleague's Conference Setup dialog box selections are set to listen for your 
incoming call.

For troubleshooting modem or network (NetBIOS or NetWare) configurations, see the following topics in 
the Communications Test on-line Help:

Modem connection problems

NetWare connection problems

NetBIOS connection problems

For key information about how the ProShare application works, search in this Help system for the word 
Tip or the phrase "Important tip" (surrounded by " marks).



 Introduction to the ProShare Personal Conferencing software 

ProShare Personal Conferencing software is a document conferencing program that presents a shared 
workspace on two computers that are connected by modem or network.    You and your colleague 
simultaneously view and mark up documents in the ProShare application's workspace while talking with 
each other over the phone.

The Premier Edition software enables running an application on one conference participant's system 
while the other participant views the same running application.    The application host has the capability 
to enable or block the guest participant from editing or otherwise interacting with the application.

The ProShare application can help you save time, avoid travel, clearly convey ideas, and receive 
feedback on those ideas quicker than ever before.    For example, you can use the ProShare application 
to...

· Show or send the latest version of a document to a colleague on the other side of the building.

· Walk through and make changes to a presentation with a co-worker at another site.

· Review a contract with your legal department in another state.

· Show the latest design specifications to a client or customer anywhere in the world.

...all interactively without traveling or faxing.    When you need to share information with someone at a 
different location, the ProShare application helps you make your points clearly and get feedback 
quickly.    In short, the ProShare application helps you communicate, making you more productive in 
your daily work.

The ProShare application's workspace looks like a stack of paper pages, or a notebook.    Both 
conference participants access the same pages at the same time.    Either of you can create a new 
page and fill it with information or mark on an existing page.    As you use the program to share 
information, you talk to the other person using a phone.

As an added bonus, you can devote part of the ProShare application's workspace to a private 
workspace where you can take notes that the other participant cannot see.

____________
Important tip

This version (1.6) of the ProShare Personal Conferencing software cannot connect with version 1.5 
because the connection methods have changed.    However, you can open a file saved from the 1.5 
software, and the 1.6 software automatically converts it to the 1.6 format.

Where to go from here

To go to the next introductory topic, click the >> button in the button bar near the top of this window.

To see an outline of all the major topics in this Help file and other related Help files, click the Bookcase 
button near the top of this window.

____________
Tip

The ProShare application offers context-sensitive Help.    When you're in the ProShare application and 
want to know about a menu command, select the command and press F1.    When you want to learn 
about a dialog box, press F1 or click the Help button in the dialog box.    When you want to learn about 
a portion of the main window or a toolbox, press Shift+F1 and then click on the interface element, 
except as follows:



· the main window's menu bar

· the control menu on the main window, on the floating Annotation toolbox, and on the Data Capture 
toolbox

· the title bar and the minimize button on the Data Capture toolbox

In addition to context-sensitive topics, this Help file contains many topics on how to use the ProShare 
application.    For a list of all these topics, click the Contents button near the top of this window, then 
click the How to... button in the Contents topic window.









 ProShare application's main window

The following pictures show the ProShare application's main window and Data Capture toolbox when 
connected to another participant.    To learn about the window and toolbox, you can click on areas of the 
pictures below, or from within the ProShare application, press Shift+F1 and then click on the the 
application window or toolbox itself.

Click on an area of the window or toolbox for information.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help is not available for the following 
interface elements:

· the main window's menu bar

· the control menu on the main window, on the floating Annotation toolbox, and on the Data Capture 
toolbox

· the title bar and the minimize button on the Data Capture toolbox

____________
See also

Moving around in the notebook

Setting your notebook preferences

Page Sorter dialog box

Application sharing windows





snapshot tool

Using the snapshot tool, you can "take a picture" of information in another window for insertion onto a 
notebook page.



crop tool

Using the crop tool, you can "take a picture" of a portion of a window that you define by clicking and 
dragging the mouse.    The snapshot of the information is then inserted onto a notebook page.



restore tool

Brings the ProShare application's notebook to the top of your screen.



title bar - Data Capture toolbox

Contains the name of the window.    The title bar is highlighted for the currently active window.





share application tool

Displays the Share Application View dialog box to let you choose an application to share.

____________
Tip

When you are not connected to another participant, on color monitors this button is gray to indicate the 
action is unavailable.    Shift+F1 context-sensitive Help is not available for the button when its action is 
unavailable.



view-only tool

If you are the host of the shared application, choosing this tool toggles whether or not the guest can 
interact with the shared application.



stop sharing tool

Stops sharing all shared applications, and exits application sharing.    However, the applications remain 
open on the host's system until specifically closed.

____________
Tip

When you are not connected to another participant, on color monitors this button is gray to indicate the 
action is unavailable.    Shift+F1 context-sensitive Help is not available for the button when its action is 
unavailable.





sizing border

Use the window border to resize a window with the mouse.    Position the mouse at any border of the 
window and drag that border until the window is the desired size.



control menu

In Windows applications, windows and some dialog boxes have a control menu.    The control menu 
provides commands for moving, sizing, and closing windows and dialog boxes.    Control menu 
commands are grayed out or omitted when they are not available.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help is not available for the control menu.



title bar - main window

Contains the name of the window.    The title bar is highlighted for the currently active window.    The 
ProShare application's title bar contains the filename of the most recently saved or opened meeting file 
(or "Untitled" if none has been saved or opened).    If the Link Public and Private Pages check box is 
deselected in the Preferences dialog box, the title bar also displays the filename of the most recently 
saved or opened private notes file (or "Untitled").



minimize button

Reduces the active window to an icon.



maximize button

Enlarges the size of the active window to its maximum size.



menu bar

Lists the menu names, each of which displays a drop-down menu.    Select a drop-down menu by 
clicking on the name with the mouse or by pressing Alt+x, where x is the underlined letter in the menu 
name.

When a menu is pulled down, choose a command by clicking on it with the mouse, by pressing the 
underlined number or letter of the name, or by using the down and up arrows on your keyboard to 
select the command and then pressing Enter.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help is not available for the menu bar.



Attendee status bar

Shows the names of the conference participants, and the current page number of each participant's 
notebook.    Double-click the page number of the other participant to synchronize pages, that is, to move 
to that same page.



Annotation toolbox

Tools in the Annotation toolbox correspond to actions that can be performed through a Toolbox menu 
command.    The buttons bypass the commands and directly choose the action without opening the 
menu.    The lower six tools in the Annotation toolbox can be any combination of highlighters, pens, text 
tools, rectangles, ellipses, or straight lines.

You can configure any of these tools with the Configure Tool or Configure Remote Pointer command 
(from the Toolbox menu) or by double-clicking the tool.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help accesses this topic when you click on 
the window background anywhere near the Annotation toolbox.



spiral

Conveys the concept of a notebook of pages.    To turn the spiral on or off, choose the Preferences 
command from the View menu to display the Preferences dialog box, then select or deselect the Spiral 
and Border check box.



public workspace

The top section of the notebook page. If you place information in the public workspace (using the 
snapshot tool, making marks, pasting, or importing a file), the other participant can see that information.



private workspace title

The Private workspace can include a title bar that separates it from the public workspace.    To turn the 
Private title bar on or off, choose the Preferences command from the View menu to display the 
Preferences dialog box, then select or deselect the Private Title Bar check box.



private workspace

The private workspace, when visible, appears below the public workspace.    If you place information in 
the private workspace, the other participant cannot see it.

The title "Private" (or a heavy line if Private Title Bar is turned off in the Preferences dialog box) divides 
the workspace into public and private workspaces.    When you pass your cursor over the private 

workspace divider, the cursor changes to a sizing cursor  that you can drag up or down to 
resize the workspaces.



tab scroll up arrow

When the notebook contains more pages than the tabs can show, click on the tab scroll up arrow to 
reveal the previous tab.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help accesses the Tabs topic when you 
click on the tab scrolling arrows.



tabs

The numbered tabs correspond to the pages in the notebook.    The tab of the current notebook page 
displays a blue number on a white background.

The private workspace contains tabs if the Link Public and Private Pages check box is deselected in the 
Preferences dialog box.

Click on a tab to jump to its page.    Double-click a tab to synchronize pages with the other participant 
(that is, to move both you and the other participant to that page).

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help accesses this topic when you click on 
the tab scrolling arrows, the new page tab, or the window background anywhere near the tabs.



new page tab

The New page tab adds a new blank page to the notebook.

If the new page tab has scrolled out of view, click on the tab scroll down arrow to reveal it.

The private workspace contains tabs if the Link Public and Private Pages check box is deselected in the 
Preferences dialog box.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help accesses the Tabs topic when you 
click on the new page tab.



tab scroll down arrow

When the notebook contains more pages than the tabs can show, click on the tab scroll down arrow to 
reveal the next tab.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help accesses the Tabs topic when you 
click on the tab scrolling arrows.



status bar

The status bar at the bottom of the main window contains information about the tool or command 
currently selected, and the number of the notebook page displayed.    To turn the status bar on and off, 
choose the Preferences command from the View menu to open the Preferences dialog box and select 
or deselect Status Bar.



window background

No action occurs when you click in this area.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help accesses the Annotation toolbox topic 
when you click on the window background anywhere near the Annotation toolbox.

Also, Shift+F1 context-sensitive Help accesses the Tabs topic when you click on window background 
anywhere near the tabs.





 Application sharing windows

To initiate application sharing, the host participant executes the Share Application View command from 
the Application menu.    The guest participant views the application through the Sharing window.    If the 
guest's view of the application is smaller than the host's, the guest's system also displays a Pan 
window.

The Sharing window

During application sharing, a Sharing window appears on the guest's system.    This window contains 

the application(s) being shared.    A sharing mode graphic  appears in the title bar of any shared 
applications within the Sharing window.

The Sharing window can never be made larger than the physical screen or video resolution of the host's 
system.    For example, if the host screen is a nine-inch laptop, the guest cannot make the Sharing 
window any larger than nine inches on his or her screen.

You can alternate the Sharing window between full screen and normal size by pressing Ctrl+Alt+F, or by 
choosing the Full Screen command from the Sharing window's control menu.

If the host places another window on top of the shared application window on his or her system, the 
guest sees green diagonal lines appear over the shared application in the Sharing window.



These lines indicate to the guest that the information under the lines might not be current.    The guest 
may be able to click in an area of the shared application that is not covered by the diagonal lines to make 
the Sharing window active and update the guest's screen.    (This technique won't work if the obscuring 
item on the host's screen requires an action from the host to make the obscuring item go away, such as a 
system error message dialog box.)

You can force a screen redraw by pressing Ctrl+Alt+R.

The Pan window

If the Sharing window is smaller than the shared application window on the host's screen, or the video 
resolution of the host's system exceeds that of the guest's, a Pan window appears on the guest's 
system.

The Pan window shows a thumbnail size of the shared application, as the host sees it.    In the Pan 
window, the part of the application currently visible to the guest is outlined in gray.    The guest can drag 
the gray outlined window to make other areas of the application visible.    A black dot inside the Pan 
window shows the location of the guest's cursor in relation to the entire application window (as seen on 
the host screen).

The guest can minimize the Pan window, but not close it.    If the guest enlarges the Sharing window so 
that it appears on the guest system as it does on the host system, the Pan window closes.

____________
Important tip

When you begin application sharing, if the ProShare software detects differing keyboard drivers, the 
software displays a message suggesting that you execute in view-only mode.    Keyboard drivers, 
especially those that enable keyboards for different languages, can interpret keystrokes differently.    
Use the view-only tool to toggle between interactive and view-only modes.

____________



See also

Sharing an application







 Moving around in the notebook

When you first start the ProShare Personal Conferencing application, a notebook with one page and 
the Data Capture toolbox appear.

To add a new page:

· Click the new page tab in the application.    A new tab appears with the new page number on it.



To delete a page:

· Make the page you plan to delete the current page.    Then, from the Edit menu, choose the Delete 
Page - Public command.

or

In the Page Sorter dialog box (View menu), select the page and choose Delete or drag the page to 
the Delete button.

____________
Important tip

If the Link Public and Private Pages check box is selected in the Preferences dialog box (the private 
workspace does not have tabs), the Delete Page - Public command also appears to delete annotations 
in the private workspace.    However, if you subsequently select Link Public and Private Pages in the 
Preferences dialog box, those deleted annotations actually still exist on an independent private page 
(until you delete them individually or with the Delete Page - Private command).

To scroll around on a page:

· Use the scroll bars for the page.

or

When you are not in a text annotation, press the arrow keys, PgUp, or PgDn to scroll the current 
page in a particular direction, the Ctrl+arrow keys to scroll half a screen in a particular direction, or 
the Home or End key to scroll to the top left or bottom right of the page.

To switch from page to page:

· Click the numbered tab of the desired page.

or

Press the Ctrl+PgUp or Ctrl+PgDn keys until the desired public page appears.

or

When you are not in a text annotation, press the Ctrl+Home or Ctrl+End keys to move to the first or 
last public page.

To scroll a hidden page tab into view:

· Tab scroll arrows appear when the notebook contains so many pages that all the tabs cannot be 
displayed.    Click the tab scroll up or tab scroll down arrows until the desired tab appears.    This 
method doesn't change the current page, it only brings more tabs into view.

To see several pages at once:

· From the View menu, choose the Page Sorter command to open the Page Sorter dialog box.    You 
can leave the Page Sorter dialog box open while you perform other tasks.

____________



See also

Working in the private workspace

Navigation and editing keys





 Making annotations in the notebook

Making annotations (marks) in the notebook is as easy as using a pen or highlighter on paper.    When 
you save your meeting file, all the annotations are saved with the file.    Once you make an annotation, 
you can move, copy, paste, resize, or delete it.

To select one or more existing annotations:

1. Select the selection pointer from the Annotation toolbox by clicking on it.

2. Click on one annotation in the notebook.    Handles  appear around its border.
3. Optionally Shift+Click to select multiple annotations.

To make annotation on a page:

· Select a marking tool from the Annotation toolbox by clicking on it.    Then use the tool as follows:

· Click and drag the pen or straight line tool to draw lines on the page.    (To create straight lines 
constrained to horizontal, vertical, or 45-degree angles, press and hold the Shift key while 
dragging.)

· Click and drag the highlighter tool to emphasize something on the page.

· Click and drag the rectangle or ellipse tools from corner to diagonal corner to draw the shapes. 
(To create squares or circles, press and hold the Shift key while dragging.)

· Click with the text tool on the page where you want the text to start, then type.    The text does 
not automatically wrap to the next line; you need to press Enter to start a new line.

To edit an existing text annotation:

· Select the selection pointer and single-click the text annotation.    Press the Enter key to place the 
text insertion cursor at the end of the annotation.

· Select the text tool and click on the annotation.

· Use the arrow keys to move the cursor through the text.

· Select the selection pointer and double-click the text annotation.

____________
Tip

When the Annotation toolbox is floating (Float Annotation Tools is selected in the Preferences dialog 
box), double-clicking anywhere on the page usually moves the toolbox to that spot, with the following 
exceptions when clicking a text annotation:

· If the current tool is the selection pointer and you double-click on a text annotation, the toolbox 
does not move.    (The text insertion cursor is placed in the text annotation.)

· If the current tool is the text tool and you double-click on a text annotation, the text insertion cursor 
is placed in the text annotation and the toolbox is placed over the top of the annotation.

To move an annotation on a page:

· Select the selection pointer from the Annotation toolbox, then click on the annotation and drag it.    
You can select and move snapshots and imported documents like any other annotation.    Each 
annotation must be moved separately.    You cannot select, move, or delete multiple annotations.



To delete an annotation on a page:

· Select the selection pointer from the Annotation toolbox, then click on the annotation.    From the 
Edit menu, choose the Cut command (or press Delete).    You also can delete a snapshot or an 
imported document from a page using this method.    Note that only one participant can select an 
annotation at any time.

To resize an annotation:

· Select the selection pointer from the Annotation toolbox, then click on the annotation.    From the 
Edit menu, choose the Resize command

or

When an annotation is selected, handles  appear around its border.    Drag one of the 
handles to stretch or shrink the annotation in that direction.    For straight lines, drag either end 
handle to stretch or collapse the line or change its direction.

____________
Important tip

For annotations other than rectangles, ellipses, and straight lines, use Shift+drag to resize the 
annotation and retain its proportions (aspect ratio).    When you use Shift+drag on a rectangle or ellipse, 
it changes to a square or circle, respectively.    When you use Shift+drag on a straight line, it constrains 
the line to horizontal, vertical, or 45-degree angles.

____________
See also

Bringing information into the notebook







 Setting your notebook preferences

Both conference participants can customize their own ProShare application notebooks to suit personal 
needs.    Once set, these preferences are in effect for every session until you specifically change any of 
them.    The View menu, Toolbox menu, and Conference menu contain commands that let you set 
preferences or otherwise configure your application.

To configure the notebook page and the status bars:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
From the Display Controls check boxes, select the elements you want to show in the notebook, 
then choose OK.

To link or separate the private workspace pages with the public pages:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select or deselect the Link Public and Private Pages check box, then choose OK.

To select the number of colors used to display graphics:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
From the Display Graphics Using buttons, select a method for displaying graphics, then choose 
OK.

To toggle displaying the Annotation toolbox or the Data Capture toolbox:

· From the View menu, choose the Annotation Tools or Data Tools command.

To make the Annotation toolbox an independent, floating window:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select Float Annotation Tools, then choose OK.    Note that you cannot move the Annotation toolbox 
outside of the workspace window, whereas the Data Capture toolbox floats anywhere on top of your 
screen.

To configure the remote pointer in the Annotation toolbox:

1. Select the remote pointer from the Annotation toolbox by clicking on it.    From the Toolbox menu, 
choose the Configure Remote Pointer command to open the Configure Remote Pointer dialog box.

or

Double-click the remote pointer.

2. Select the color of the remote pointer; then choose OK.

To configure a tool in the Annotation toolbox:

1. Select the tool from the Annotation toolbox by clicking on it.    From the Toolbox menu, choose the 
Configure Tool command to open the Configure Tool dialog box.

or

Double-click the annotation tool.

2. Select the type and characteristics of the tool, then choose OK.

To show the notebook in full screen mode:

· Full screen mode displays status bars, spirals, and tabs if you have them enabled; it does not 



display the title bar and menu bar.    From the View menu, choose the Full Screen command.    To 
return to notebook mode, press F7 or Escape.    While in full screen mode, you can access the 
menus by pressing Alt+ the letter of the desired menu:

Alt+F for the File menu Alt+C for the Conference menu
Alt+E for the Edit menu Alt+A for the Application menu
Alt+V for the View menu Alt+H for the Help menu
Alt+T for the Toolbox menu

To specify how an open meeting file will be handled at connection:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
From the Connection Merge Controls buttons, select the method you prefer, then choose OK.

To receive notification of incoming connections:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select the Enable Call Screening check box, then choose OK.

To set your own name and how names are displayed:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Choose the Names button to open the Names dialog box.    Specify your name (as displayed by the 
application) and how names are displayed, then choose OK.

To use JPEG compression when transferring data to the other participant:

When the application uses JPEG compression, the information shared in the notebook is 
compressed before transferring it between participants.    As a result, the data transmission is faster 
but the resolution of the image is not as good.

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select the Use JPEG Compression check box, then choose OK.

To set the types of conference connections you want your ProShare application to accept (these 
settings do not affect outgoing connections):

· From the Conference menu, choose the Setup command to open the Conference Setup dialog box. 
Select the connection methods, then choose OK.

To set the connection information for your modem (these settings affect both incoming and 
outgoing connections):

· From the Conference menu, choose the Setup command to open the Conference Setup dialog box. 
Choose the Set Modem button to open the Set Modem dialog box.    Select the settings that match 
your modem configuration, then choose OK once to exit the Set Modem dialog box, and again to 
exit the Conference Setup dialog box.





 Working in the private workspace

The ProShare application's notebook contains a private workspace where you can record private notes 
during a conference.    The private workspace is a sizable region on the lower part of your notebook.    
The notes in this area are not visible to the other conference participant.    When you save a notebook, 
the private notes are saved with the rest of the notebook.

You can work with the private workspace in two ways:

· Link your private pages to your public pages so that both parts of the notebook track together as 
you change pages.

or

· Set your private page to be independent of your public notebook pages, so that changing a public 
page doesn't change the private page you see.

To open the private workspace:

· From the View menu, choose the Private Workspace command.

or

· Use the sizing cursor :
Slowly pass the current cursor over the lower edge of the public workspace.    When the cursor 

changes to the sizing cursor, click and drag it up until the private workspace is the desired size.
or
Slowly pass the current cursor over the lower edge of the public workspace.    When the cursor 

changes to the sizing cursor, double-click to open the private workspace.

To size the private workspace:

· Pass the current cursor over the dividing area between the public and private workspaces.    Click 
and drag the sizing cursor up or down until the desired private workspace size appears.

To close the private workspace:

· From the View menu, choose the Private Workspace command.

or

· Pass the current cursor over the dividing line between public and private workspaces.    Double-

click the private workspace sizing cursor .

To record information in a private page:

· Select a tool from the Annotation toolbox and make annotations (marks) in the private workspace.

or

· Use the snapshot or crop tool to capture information, then choose the New Private Page or Current 
Private Page command from the pop-up menu.

or

· From the Edit menu, choose the Paste - Private command to paste information from the Clipboard 



into the current private page.

or

· From the Edit menu, choose the Paste Special command to open the Paste Special dialog box.    
Choose the Paste Private button to paste information from the Clipboard.

To make private pages a separate notebook independent of public pages:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Deselect the Link Public and Private Pages check box, then choose OK.    Notice that the private 
workspace now has its own set of tabs.

To turn the title to the private workspace on and off:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select Private Title Bar, then choose OK.

To switch from private page to private page when private pages are not linked to public pages:

· Click the numbered tab of the desired private page.

or

Press the Alt+PgUp or Alt+PgDn keys until the desired private page appears,
or the Alt+Home or Alt+End keys to move to the first or last private page.

____________
Important tip

If the Link Public and Private Pages check box is selected in the Preferences dialog box (the private 
workspace does not have tabs), the Delete Page - Public command also appears to delete annotations 
in the private workspace.    However, if you subsequently select Link Public and Private Pages in the 
Preferences dialog box, those deleted annotations actually still exist on an independent private page 
(until you delete them individually or with the Delete Page - Private command).

____________
See also

Delete Page - Private command



 Bringing information into the notebook

Any information that you can see on your computer screen in Windows can be placed into your 
ProShare application notebook and shared with someone else.    Placing the information into the 
ProShare application notebook doesn't change the original, only a copy is placed in the notebook.    You 
can mark on the information and make notes about it, without changing the underlying information.

You add information to the notebook in the following ways:

· Paste information using the Paste commands.

· Paste information using the Paste Special command, including embedding an OLE object.

· Take snapshots of windows or regions on your screen.

· Import an entire file (or selected pages from it) that was created in another application.

· Print directly from another application into the ProShare application notebook.

Importing information or taking snapshots while connected to someone else can require several 
minutes to transfer over the modem or network.

Pasting information using the Paste commands

You can paste into your notebook any information copied to the Windows Clipboard.

To paste information using the Paste commands:

1. Open the other application and create the desired information or open an existing file.

2. Use the application's menus and commands to Cut or Copy the desired information onto the 
Windows Clipboard.

3. Bring the ProShare application notebook to the top of your screen by one of the following methods:

Click the return tool in the Data Capture toolbox.

Click on any visible portion of the ProShare application.

Press and hold the Alt key, then press the Tab key repeatedly until the ProShare application name 
is displayed.

Press Ctrl+Escape to display the Windows Task List, select the ProShare application, and choose 
Switch To.

4. From the ProShare application's Edit menu, choose the Paste - Public command.    The ProShare 
application puts the information in the upper left corner of the notebook page.    (The information is 
now just another annotation.)

If the information is text, the ProShare application inserts it as a text annotation--you can double-
click a text annotation to edit the text.

If the information is not text, the ProShare application inserts the information as a bitmap picture.

Making annotations in the notebook describes how to move the information.

For information on the Paste - Private command, see Working in the private workspace.

____________
Important tip

When you paste text, the text attributes (color and size, normal, bold, or italic) match the configuration 
of the first text tool from the top of the non-floating Annotation toolbox, or 12 point normal black text if no 
text tool is defined.    Note, however, if the text annotation was copied or cut to the Clipboard from the 



ProShare application itself, its attributes do not change to match the current text tool, but remain the 
same as when copied or cut from the notebook.    You cannot change the attributes of an existing text 
annotation, but you could delete the annotation, re-configure your topmost text tool, then copy (from 
another application) and paste the annotation again.

Pasting information using the Paste Special command

Some applications copy information to the Windows Clipboard so that you can paste the information 
and retain certain characteristics with the information, such as a particular format and an association to 
the originating application.

To paste information using the Paste Special command:

1. Open the application that supports the Paste Special feature and create the desired information or 
open an existing file.

2. Use the application's menus and commands to Cut or Copy the desired information onto the 
Windows Clipboard.

3. Bring the ProShare application notebook to the top of your screen by one of the following methods:

Click the return tool in the Data Capture toolbox.

Click on any visible portion of the ProShare application.

Press and hold the Alt key, then press the Tab key repeatedly until the ProShare application name 
is displayed.

Press Ctrl+Escape to display the Windows Task List, select the ProShare application, and choose 
Switch To.

4. From the ProShare application's Edit menu, choose the Paste Special command to open the Paste 
Special dialog box.

5. Select a format.    If you select a format that ends in the word "Object," you create an embedded 
OLE object and retain all formatting plus the ability to update the object in the originating 
application.    For more information, see Embedding OLE information from another application.

6. To paste the information on the current public page, choose Paste.

or

To paste the information on the current private page, choose Paste Private.

When you choose a Paste button in the Paste Special dialog box, the ProShare application puts the 
information in the upper left corner of the notebook page.    (The information is now just another 
annotation.)    Making annotations in the notebook describes how to move the information.

Taking snapshots of information on your screen

If the information you want to share is small enough to appear in its application window, you can take a 
snapshot of that window and insert the snapshot in the ProShare application notebook.    Note that the 
Data Capture toolbox will never appear in a snapshot.

To take a snapshot of another application window:

1. Open the other application and create the desired information or open an existing file.

2. Click the snapshot tool in the Data Capture toolbox, then position the cursor over the open window. 
To show you which information will be captured, the region is highlighted with diagonal lines.    The 
region changes as you move the cursor.

3. Click again to display the pop-up menu of notebook destinations.    (Note that the information is 
captured when you choose a destination, not when you first click the tool--mportant to consider 



when capturing from a video window.)

4. To create a new page at the end of the notebook and place the snapshot on that page, choose the 
New Page command (or press Enter).

5. To place the snapshot on the current notebook page, choose the Current Page command.    The 
ProShare application always puts the snapshot in the upper left corner of the notebook page.    (The 
snapshot is now just another annotation.)    Making annotations in the notebook, describes how to 
move the snapshot.    For information on the Private command choices, see Working in the private 
workspace.

To take a snapshot of a portion of a window:

1. Click the crop tool in the Data Capture toolbox.

2. Position the cursor at one corner of the region you want to capture.

3. Click and drag the cursor diagonally to the opposite corner of the region, then release the mouse 
button (or click on one corner of the region, then on the opposite corner).    (Note that the 
information is captured when you choose a destination, not when you first click the tool--mportant to 
consider when capturing from a video window.)

4. To place the snapshot on a new notebook page, choose the New Page command (or press Enter).

5. To place the snapshot on the displayed notebook page, choose the Current Page command.    The 
ProShare application puts the snapshot in the upper left corner of the notebook page.    (The 
snapshot is now just another annotation.)    Making annotations in the notebook, describes how to 
move the snapshot.    For information on the Private command choices, see Working in the private 
workspace.

To cancel a snapshot:

· From the pop-up menu, choose the Quit Snapshot command (or press Escape).

· If you clicked the snapshot tool, click anywhere on the Data Capture toolbox.

To delete a snapshot from a page:

· From the Annotation toolbox, choose the selection pointer, then click on the snapshot (annotation) 
in the notebook.    From the Edit menu, choose the Cut command (or press Delete).

Importing files

To import all or selected pages from a file created in another application, see Importing all or part of a 
file.

____________
Tip

The most recently added annotation is topmost on the ProShare application notebook page.    To bring 
an annotation to the top, select the annotation, choose the Cut command from the Edit menu, then 
choose a Paste command from the Edit menu.



 Importing all or part of a file

You may need to bring more information into the ProShare application than fits in an open application 
window.    The ProShare application understands several graphics file formats and can import those 
files directly into the notebook.    For other file formats, the ProShare application can print the file right 
into the notebook pages rather than to a printer.

To import an entire file:

1. From the ProShare application File menu, choose the Import command to open the Import dialog 
box.

2. Select the drive, directory, and name of the file you wish to import, then choose OK.

3. The Import Using dialog box appears.    From the list, select the file type.

For the graphics file types listed, the ProShare application imports the image directly onto a new 
notebook page, preserving the number of colors in the original image.

For other file types, select Print Capture.    The ProShare application determines which application 
to use, opens the file in the application, changes the printer driver temporarily to its own "capture" 
driver, prints the file into the public workspace, resets the printer driver to its previous setting, and 
closes the application.    Graphics within such files are imported in a maximum of 16 colors.

To capture selected pages from a file:

1. The file's originating application must support printing selected pages.    Open the other application 
and open the file you want to capture.

2. Use the application's Print Setup command to display available printer drivers.    Note which driver 
is currently selected, so you can change back when you're done.    Select the PSData Capture 
Driver.    Choose OK (or other appropriate command) to enact the change.

3. Use the application's Print command and specify the pages to print.    Start the printing.

4. Again, use the application's Print Setup command to display available printer drivers.    Re-select 
the original driver (the one you made note of in step 2).    Choose OK (or other appropriate 
command) to enact the change.

5. Close the file and application.

6. Bring the ProShare application notebook to the top of your screen by one of the following methods:

Click the return tool in the Data Capture toolbox.

Click on any visible portion of the ProShare application.

Press and hold the Alt key, then press the Tab key repeatedly until the ProShare application name 
is displayed.

Press Ctrl+Escape to display the Windows Task List, select the ProShare application, and choose 
Switch To.

____________
Important tip

Using the ProShare print capture driver limits importing to 16 colors.    To retain more than 16 colors:

· If possible, use the Import command from the File menu and select the file's type in the Import 
Using dialog box (do not select Print Capture or Text File).

or

Open the image in its originating application, and then take a snapshot of the image using the 
snapshot or crop tools from the Data Capture toolbox.



When importing doesn't work

The ProShare application cannot invoke some applications for printing when you choose the Import 
command and the Print Capture file type.    (The ProShare application invokes another application for 
printing using a '/p' command line option or a DDE message in the Windows registration database.)    If 
you tried the Import command and were unsuccessful, you can verify that the application does not 
support being invoked for printing.    For those applications, you can print from within the application 
itself (like capturing selected pages from a file, above).

To verify that an application does not support being invoked for printing:

1. Open the Windows File Manager.

2. Select (highlight) the file you want to import.

3. From the File menu in File Manager, choose the Print command.

If the file does not print from File Manager, it cannot be captured to the ProShare application 
notebook using the Import command.    Instead, use the procedure below.

To capture pages from a file whose application does not support File Import:

1. Open the other application and open the file you want to capture.

2. Use the application's Print Setup command to display available printer drivers.    Note which driver 
is currently selected, so you can change back when you're done.    Select the PSData Capture 
Driver.    Choose OK (or other appropriate command) to enact the change.

3. Use the application's Print command and specify the pages to print.    Start the printing.

4. Again, use the application's Print Setup command to display available printer drivers.    Re-select 
the original driver (the one you made note of in step 2).    Choose OK (or other appropriate 
command) to enact the change.

5. Close the file and application.

6. Bring the ProShare application notebook to the top of your screen by one of the following methods:

Click the return tool in the Data Capture toolbox.

Click on any visible portion of the ProShare application.

Press and hold the Alt key, then press the Tab key repeatedly until the ProShare application name 
is displayed.

Press Ctrl+Escape to display the Windows Task List, select the ProShare application, and choose 
Switch To.



 Setting up the print capture driver

The ProShare application uses its own print capture driver for printing files created by other 
applications:

· When importing a file that is not one of the graphics file types listed in the ProShare application's 
Import Using dialog box.    The ProShare application opens the application that originally created 
the file and prints the file into the ProShare application notebook using the print capture driver.

· When you specify the print capture driver to be your current printer or default printer from within 
another application or from Windows Control Panel.    Then each time you print from the application, 
the output is printed into the ProShare application notebook using the print capture driver.

The print capture driver can be configured similar to other printers using the Print Capture Driver - 
PROSHARE dialog box:

To display the Print Capture Driver - PROSHARE dialog box:

· From your application's Print Setup command (or equivalent), select PSDATA Capture Driver on 
PROSHARE, and choose the Options or Setup button (if available).

or

· From Program Manager, double-click the Windows Control Panel icon.    Then double-click the 
Printers icon.    Select PSDATA Capture Driver on PROSHARE.    Then choose Setup.

To set the paper size and page orientation options:

1. Set the Paper Size controls using one of the following methods:

Select a page size from the Paper drop-down list.

Select the Scale output to display check box and select a screen resolution for your display from 
the Display size for scaling list.

2. Set the Orientation:

Select Landscape (wider than tall) or Portrait (taller than wide).

3. Choose OK to exit the Print Capture Driver - PROSHARE dialog box.



4. Choose Close to exit the print options or setup dialog (or equivalent if you are in another 
application).

5. From the Settings menu in Control Panel, choose Exit to close the Control Panel (or equivalent if 
you are in another application).

____________
Important tip

Using the ProShare application's print capture driver limits importing to 16 colors.    To print more than 
16 colors into the ProShare application notebook:

· For graphics files, use the Import command from the ProShare application's File menu and select 
the correct graphic file type in the Import Using dialog box (do not select Print Capture or Text File).

or

· Open the file in its originating application, and then take a snapshot of the data using the ProShare 
application's snapshot or crop tools from the Intel Data Capture toolbox.



 Embedding OLE information from another application

The Windows term "OLE" means Object Linking and Embedding.    Information created by one program 
and pasted into another can be an OLE object.    These objects can include graphics, text, 
spreadsheets, and other forms of information.

When you embed an object, you place information created in one application into another application, 
retaining all the native characteristics of the object, including remembering the originating application.    
Embedding the object is similar to copying, with a couple of differences.    For example, when you 
double-click on an embedded object, the originating application opens so you can update the object's 
information within that application.

Embedded OLE objects only are available from applications that support OLE, called OLE servers.    An 
object in the ProShare application notebook maintains its OLE status in the other participant's notebook 
as well, so both participants can open and update the object--as long as the participant doing the 
updating has the originating application installed.    Note that if both participants need to update the 
object, both participants must have compatible versions of the originating application (often the same 
version, depending on the application).    Only one participant can open and update an OLE object at a 
time.

Participants running the Jump Start version of the ProShare software cannot embed or update OLE 
objects.

____________
Important tip

When a document or spreadsheet is embedded in the notebook, the entire spreadsheet or document is 
embedded--not just the portion you have copied for pasting.    Some OLE server applications implement 
OLE this way, this is not a problem with the ProShare application.    Keep this in mind when you're 
working with confidential information since the person with whom you're conferencing could open and 
view your entire document.

The ProShare application does not link an OLE object to its original document.    Changing the original 
document does not change the OLE object.

To embed an OLE object:

1. Open the application and create the desired object or load the document.

2. Use the application's menus and commands to Cut or Copy the desired information onto the 
Windows Clipboard.

3. Bring the ProShare application notebook to the top of your screen by one of the following methods:

Click the return tool in the Data Capture toolbox.

Click on any visible portion of the ProShare application.

Press and hold the Alt key, then press the Tab key repeatedly until the ProShare application name 
is displayed.

Press Ctrl+Escape to display the Windows Task List, select the ProShare application, and choose 
Switch To.

4. From the ProShare application's Edit menu, choose the Paste Special command to open the Paste 
Special dialog box.

5. In the Paste Special dialog box, select the format labeled application Object from the list, where 
application is the name of the application from which you copied.

Note that the application from which you want to embed information must be an OLE server.    If the 



application cannot treat information as OLE objects, the application Object format will not be 
available.

6. To embed the object on the current public page, choose Paste.

or

To embed the object on the current private page, choose Paste Private.

7. The ProShare application puts the object in the upper left corner of the notebook page.    (The 
information is now just another annotation.)    Making annotations in the notebook describes how to 
move the object.

Usually the information itself appears on the page in the notebook.    However, some applications 
represent the embedded information with an icon, which appears on the notebook page.

After you have created the OLE object, you don't have to leave the original application running.    When 
you double-click an OLE object in the ProShare application notebook, the ProShare application 
automatically starts the originating application.

To update an embedded OLE object in your notebook:

1. Either double-click the embedded object, or click the embedded object and choose the application-
name   Object command   from the Edit menu to start the originating application.

2. Use the originating application's commands and menus to change the object as desired.

3. Choose the Save or Update command within the originating application.    You must update the 
changes you've made, or they will be lost.

4. Bring the ProShare application notebook to the top of your screen by one of the following methods:

Click the return tool in the Data Capture toolbox.

Click on any visible portion of the ProShare application.

Press and hold the Alt key, then press the Tab key repeatedly until the ProShare application name 
is displayed.

Press Ctrl+Escape to display the Windows Task List, select the ProShare application, and choose 
Switch To.

____________
Tip

When the Annotation toolbox is floating (Float Annotation Tools is selected in the Preferences dialog 
box), double-clicking anywhere on the page usually moves the toolbox to that spot, with the following 
exception when double-clicking an OLE annotation:

· If the current tool is the selection pointer and you double-click on an OLE annotation, the toolbox 
does not move.    (The OLE annotation is opened in its originating application.)



 Using special conference features

The ProShare Personal Conferencing application provides several features that help you conduct a 
conference.    The Attendee status bar is below the menu bar.    It lists conference participants and the 
page number that each participant is currently viewing.    You can use the remote pointer to point to 
something on a page and the other participant can see your pointer.    When you want to synchronize 
notebooks (that is, bring both participants to the same page), you can use one of several methods.

To enable the Attendee status bar:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select the Attendee Status Bar check box, then choose OK.

To use the remote pointer:

· Select the remote pointer from the Annotation toolbox.    When you click and drag the pointer on a 
notebook page, the other participant can see your pointer.    To change the color of the remote 
pointer, double-click on the remote pointer tool in the Annotation toolbox to open the Configure 
Remote Pointer dialog box.

To synchronize the participants' notebooks:

· Double-click the tab of the page you want made current for both participants.

· In the attendee status bar, double-click the page number of the other participant to cause you to 
move to that same page.

· From the Edit menu, choose the Synchronize Pages command to cause the other participant to 
move to your page.

· Press Shift+Ctrl+PgUp or Shift+Ctrl+PgDn to move both participants to the previous or next page,
or press Shift+Ctrl+Home or Shift+Ctrl+End to move both participants to the first or last page.



 Setting your connection preferences for incoming connections

You defined your conferencing setup during the installation of the ProShare software, but you can 
change the settings at any time.    Your setup includes your modem information, your network 
address(es), and which connection types to listen for, as well as other settings.

To set up the connection methods your software will accept:

1. From the Conference menu, choose the Setup command to open the Conference Setup dialog box.

2. To listen for a particular connection type, select its corresponding check box.

3. To change your NetBIOS address, enter information in the text entry box.    Note that the case of the 
address is significant--anyone attempting a connection to you must use the same spelling and 
case.

4. The ProShare application saves any changes by default.    To make these changes apply to this 
conferencing session only, deselect the Permanent Changes check box.

5. To change your modem settings, choose the Set button to open the Set Modem dialog box, and 
close the Set Modem dialog box when you're finished.

6. Choose OK to exit the Conference Setup dialog box.

To specify how an open meeting file will be handled at connection:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
From the Connection Merge Controls buttons, select the method you prefer, then choose OK.

To receive notification of incoming connections:

· From the View menu, choose the Preferences command to open the Preferences dialog box.    
Select the Enable Call Screening check box, then choose OK.



 Connecting to another participant and starting a conference

You can connect by modem or by network to a colleague who is running the ProShare application.    If 
you connect using by modem, each participant needs two phone lines:    one for the modem connection 
and one for verbal communication.

Your conferencing setup is defined during the installation of the ProShare conferencing software.    
However, you can use the Conference Setup dialog box and the Set Modem dialog box to either verify 
or reset the setup.

Before initiating your conference connection:

Call your colleague on the telephone and make sure he or she is ready for the conference and has 
the ProShare software executing.

To connect when both participants have the ProShare application installed:

1. If you're connecting by modem, both participants must turn on their modems and have the correct 
settings in their Set Modem dialog boxes.

2. For the connection recipient:

a. When connecting by modem, from the Conference menu, choose the Setup command to open 
the Conference Setup dialog box.    Make sure the Modem check box is selected.

or

When connecting by network, from the Conference menu, choose the Setup command to open 
the Conference Setup dialog box.    Make sure the NetWare, NetBIOS, or TCP/IP check box is 
selected (whichever you'll connect on).

3. For the connection initiator:

a. From the Conference menu, choose the Connect command to open the Connect dialog box.    
Select the name of the other participant (or choose Add Name to enter a new name).

b. If you're connecting by modem and you need to define or change the recipient's phone number, 
choose the Modem button to open the Modem Connection Details dialog box.

or

If you're connecting by network and you need to define or change the recipient's network 
address, choose the Network button to open the Network Connection Details dialog box.

c. In the Connect dialog box, choose Connect to establish the connection.

To connect when only one participant has the ProShare application:

1. Send the Jump Start version of the ProShare application to your colleague using one of the 
following methods:

To send the software via modem, from the Conference menu, choose the Jump Start command to 
open the Jump Start dialog box.

To send the software via network, either electronically mail the PSJUMP.EXE file to your colleague, 
or copy the PSJUMP.EXE file to a specific directory on your network or to a bulletin board and let 
your colleague know where to find the file.    PSJUMP.EXE is located in your ProShare application 
directory.

2. Have your colleague install the software and get it running.    For more information on this process, 
see Install the Jump Start version of the ProShare application on the receiving computer in the 
Jump Start dialog box topic.

3. You, as the owner of the full version, need to initiate the conference connection.    Follow the 



directions above, now that both participants have the application installed.



 Transferring files

You can transfer one or more files on your computer to the other participant using the Transfer 
command on the File menu.    The file transfer process occurs in the background, so that participants 
can continue using other conferencing features.    You can observe the progress of the transferring in 
the File Transfer Status dialog box, and the status bar at the bottom of the notebook window displays a 
progress bar for each file.

To transfer a file:

· From the File menu, choose the Transfer command to open the File Transfer dialog box.    Select 
one or more files that you want to transfer and choose OK.

To receive the transferred file:

· The File Transfer Receipt dialog box appears on the receiving participant's screen.    The receiving 
participant must choose a location for receiving the transferred files and determines whether or not 
to overwrite files with the same names.

To stop a file transfer in progress:

· If you are the one transferring, from the File menu, choose the Transfer Status command to open 
the File Transfer Status dialog box.    Select the file from the File Transfers in Progress list, and 
choose the Abort button.

or

If you are the one receiving the file, choose Cancel in the    File Transfer Receipt dialog box.



 Working with someone who doesn't have the ProShare 
application

You can use the Jump Start feature to send the ProShare application Jump Start module, 
PSJUMP.EXE, to a colleague who doesn't have the application but wants to participate in a conference. 
(Once you are connected, you cannot choose the Jump Start command because it is unavailable.)

To connect when only one participant has the ProShare application:

1. Send the Jump Start version of the ProShare application to your colleague.    To send the software 
via modem, from the Conference menu, choose the Jump Start command to open the Jump Start 
dialog box.    To send the software via network, electronically mail the PSJUMP.EXE file, or copy the 
file to a server or bulletin board accessible to your colleague

2. Have your colleague install the software and get it running.    For more information on this process, 
see Install the Jump Start version of the ProShare application on the receiving computer in the 
Jump Start dialog box topic.

3. If you're connecting by modem, both participants must turn on their modems and have the correct 
settings in their Set Modem dialog boxes.

4. For the Jump Start recipient:

a. When connecting by modem, from the Conference menu, choose the Setup command to open 
the Conference Setup dialog box.    Make sure the Modem check box is selected.

or

When connecting by network, from the Conference menu, choose the Setup command to open 
the Conference Setup dialog box.    Make sure the NetWare, NetBIOS, or TCP/IP check box is 
selected (whichever you'll connect on).

3. For you, the connection initiator:

a. From the Conference menu, choose the Connect command to open the Connect dialog box.    
Select the name of the other participant (or choose Add Name to enter a new name).

b. If you're connecting by modem and you need to define or change the recipient's phone number, 
choose the Modem button to open the Modem Connection Details dialog box.

or

If you're connecting by network and you need to define or change the recipient's network 
address, choose the Network button to open the Network Connection Details dialog box.

c. In the Connect dialog box, choose Connect to establish the connection.



 Improving performance

Maximize the amount of memory available for use by Windows.

The more memory available to Windows, the more applications that can be loaded and the time spent 
switching between applications will be less.    To increase the amount of system memory available to 
Windows:

· Remove any unnecessary Terminate and Stay Resident (TSR) programs from conventional 
memory (DOS memory).

· Do not load any unnecessary drivers in conventional memory.

· Check for the existence of an excessively large SmartDrive or RAM disk, and reduce its size.

· Use a memory manager to ensure that you have at least 400K DOS memory available before you 
start Windows.

Maximize the amount of disk space available.

The more hard disk space available, the more meeting files that can be stored.    Windows also uses 
contiguous hard disk space to determine how large a permanent swap file can be.    The larger your 
permanent swap file, the more virtual memory that Windows has at its disposal.    To get more 
contiguous disk space, use a disk de-fragmention utility (available in many tool packages for DOS).

Ensure that the size of your system's virtual memory equals the amount recommended by 
Windows.

Sharing information with other users can involve running multiple applications under Windows at the 
same time, which places more demand on memory availability.    The more virtual memory available, the 
better performance you'll see when running multiple applications under Windows.

When you start the ProShare application, if you receive the message "Low Virtual Memory at Windows 
start!," your virtual memory setting is insufficient (usually less than 10MB).

To determine how much virtual memory you have, open Window's Control Panel, double-click the 386 
Enhanced icon, then choose the Virtual Memory button.    Choose the Change button and compare the 
Recommended Maximum Size with your current settings.    The amount of virtual memory available is a 
function of system memory and contiguous hard disk space available (see the previous section).    
Change your current setting to the recommended virtual memory size if possible.    The ProShare 
application runs most efficiently on at least 12MB of virtual memory.    Choose OK to accept the change, 
and restart Windows to activate the new setting.

You might be able to specify more virtual memory by freeing up disk space (delete files) and running a 
disk de-fragmentation utility to maximize contiguous free space.

Note that you cannot create a virtual memory swap file on a hard drive that has been compressed with 
compression software such as Stacker or DoubleSpace.

Maximize the amount of Windows System Resources available.

Close any unnecessary Windows applications, screen savers programs, etc.    To check resources 
available, from the Program Manager's Help menu, and choose the About Program Manager command. 
The resources are summarized under the 386 Enhanced Mode heading.



Operate modems at the fastest data transfer rate that both modems support.

Using the fastest data transfer rate that both modems support speeds up data transfers between you 
and your colleague, including file transfers.

Set the number of colors to display based on the information you'll be sharing.

From the View menu, choose the Preferences command.    In the Display Graphics Using section, 
select 256 colors, if possible.    In general, documents containing fewer colors require less memory to 
handle and can be transferred faster.    The ProShare application is optimized for 256 colors; therefore 
you will achieve optimum performance when operating at that setting.

When connecting with another participant, make sure the number of colors he or she is 
displaying matches yours.

If the Display Graphics Using settings in the Preferences dialog box are the same between participants, 
the best overall performance will be achieved and both of you will be viewing the same quality image.

Make sure the number of colors displayed matches the number of colors supported by your 
video card.

Display performance will be optimized by having the number of colors supported in the software match 
the number of colors supported by your video card.

Use the data capture tools for bringing high-resolution graphic images into the notebook.

Capture the smallest amount of information you need to share.    Print capturing and importing require 
more memory since full pages are printed at a time.    The data capture tools only manipulate a portion 
of the screen at a time, thus requiring less memory to operate.    The data capture tools also capture 
and display the data with all its original colors.    The print capture process is limited to 16 colors.

The print capture process typically produces larger bitmaps which take more memory and longer to 
display.    Also, importing takes extra memory to launch the application in the background and print the 
file to the notebook.

Turn on JPEG compression when sending dense, color graphic files.

Using JPEG compression on images takes more time to compress a file than the standard compression 
technique, but creates a smaller file, at the expense of some image quality.    JPEG is especially suited 
for high resolution graphic files with many colors, but not recommended for text files or graphic files with 
high contrast.





 Sharing an application

Either conference participant can start an application for sharing.    A shared application works the same 
when shared within the ProShare application as it does when run under Microsoft Windows.    However, 
when run as a shared application, both participants can simultaneously interact with the shared 
application (edit, execute commands, etc.) to create or revise the same information or object.

The participant that initiates application sharing is the host.    The host has the option to let the other 
participant, or guest, interact with the shared application (such as editing a document).    When the host 
restricts the guest to view-only mode, only the host can interact with the application.

To start sharing an application:

1. Establish a conference connection using the Premier Edition of the ProShare software.    Both 
participants must use the Premier Edition.

2. If the application to be shared is not already running, the host starts the application (the person who 
starts sharing is the host).

3. The host chooses the share application tool in the Data Capture toolbox (or chooses the Share 
Application View command from the Application menu) to open the Share Application View dialog 
box.

4. The host selects the name or icon of a running application and chooses OK.

____________
Important tip

If you share the Program Manager, the guest has access to ALL applications and their related files on 
the host's system.

To set the sharing mode:    (only the host can set the sharing mode)

· Choose the view-only tool in the Data Capture toolbox to toggle interactive mode and view-only 
modes.

or

From the Application menu in the ProShare application notebook, choose the Host and Guest Edit 
command to enable interactive mode; or choose the Only Host Edits command to enable view-only 
mode.

To determine whether interactive or view-only mode is in effect:

· On both the host and guest systems:

If the graphical indicator in the shared application's title bar contains two arrows  , the shared 
application is in view-only mode.

· On the host system:
In the ProShare application notebook, select the Application menu.    If the Host and Guest Edit 

command is checked, the shared application is in interactive mode.    If the Only Host Edits command is 
checked, the shared application is in view-only mode.

· On the guest system:

If the guest's mouse cursor is a regular arrow (when in the shared application window), the shared 
application is in interactive mode.    If the cursor has a line through it, the shared application is in 
view-only mode.

or



If the title bar in the shared application window says "Host and Guest Edit," the shared application 
is in interactive mode.    If the title bar says "Only Host Edits," the shared application is in view-only 
mode.

To stop sharing an application:

· Choose the stop sharing tool in the Data Capture toolbox.

or

From the Application menu in the ProShare application notebook, choose the Stop Sharing 
Application command.    This action stops sharing of all applications.    However, the applications 
remain open on the host system until specifically closed.

or

Close an application to stop sharing that specific application.    Any other shared applications are 
not affected.

____________
Important tip

If you'll be sharing applications in interactive mode with people in other countries, be aware that the 
other person's computer could be using a keyboard driver that maps characters differently than yours.    
This difference can cause unexpected results because keyboard drivers used in different languages 
interpret keystrokes differently.    For example, the keystrokes for the characters Y and Z are reversed in 
the US and Germany.    Certain auxiliary keys (such as Caps Lock, Shift, Alt, and Ctrl) pose additional 
problems since each driver interprets these keys differently.

When you begin application sharing, if the ProShare application detects different keyboard drivers on 
the guest and host computers, as specified in the SYSTEM.INI file, the software displays a message 
suggesting that you operate the session in view-only mode.

If operating in view-only mode is not practical, then either participant needs to change the keyboard 
driver to match the other (usually the guest changes to match the host).    In Windows Control Panel, 
double-click the International icon, and specify the country, language, and keyboard layout you want to 
use.    If this is the first time you've changed these settings, Windows asks for your original program 
disks.

Make sure you return to the original settings when you end your application sharing session.    Do not, 
under any circumstances, make changes to passwords while the keyboard is in its changed state.    You 
might not be typing what you expect and may not be able to reproduce the password later.

Answers to common questions

Why does the cursor seem to jump around?

When the host has enabled co-interaction by the guest, any mouse or keyboard action executed by 
either participant within the shared application is reflected on both participants' screens.    If both 
participants are attempting a mouse or keyboard action at the same time, the cursor might appear to 
jump around.    To reduce confusion, tell each other when you are going to move the mouse or interact 
with the application and why.    To toggle the sharing mode, the host can click the Sharing mode tool, as 
described above.

Why do colors look wrong on the guest's system?

When the guest's system has more colors than the host's system, the colors appear as expected on 
both systems.    However, if the host system is using more colors than the guest's, unexpected colors 
might appear on the guest's system.    For example, if the host system is using 16.7 million colors, but 



the guest system is using 256 colors, the guest's system has to substitute other colors for the ones it 
cannot display.

To work around the color substitution, make sure both the host's system and the guest's system are set 
to the same color resolution, or make sure the system that has the best color resolution is the guest's 
system.

What if my screen saver kicks in?

Depending on the way the screen saver is implemented, if the host's screen saver becomes active, it 
may or may not be visible to the guest participant.    (The guest's screen saver cannot affect the host.)

Why does everything seem slower than usual?

When you connect to a conference using modems, either participant might notice delays between a 
mouse or keyboard action and its displayed result.    The amount of delay depends to some extent on 
the application being used.

Do both participants have to have the same application to use application sharing?

No.    The application resides and only executes on the host's system.    The application is displayed on 
both systems.    Mouse movements or keyboard actions executed within the shared application are 
always accepted from the host's system, and from the guest's system only if the host has set the 
sharing mode to Host and Guest Edit.

Where is a file saved from a shared application?

Any file operation only affects the host's system.    If you are sharing a document and the host and guest 
agree that the guest should have a copy of the file, close the file and then use the File Transfer feature 
in the ProShare software to send the file.

If I print from a shared application, where does the printout come out?

Any print operation only affects the host's system.    If either participant executes a print command, the 
printed result depends on the print driver and printer specified in the host's configuration.

When I paste from the Clipboard, why doesn't the information appear in the shared application?

Clipboard operations, like file and print operations, only work with the host's Clipboard.    When the 
guest participant executes a Paste command in the shared application (or uses the keystroke 
equivalent, such as Shift+Insert), if information exists in the host's Clipboard, it is pasted.    Likewise, 
when either participant executes a Cut or Copy command, only the host's Clipboard is affected.

Can I share a DOS window?

Yes, but in windowed mode only (not full-screen mode).    To switch from full-screen to windowed mode, 
press Alt+Enger.    To ensure that your DOS window always opens in windowed mode, run the PIF 
editor and open the program information file for your DOS icon (usually COMMAND.PIF).    Ensure that 
Windowed is selected in the Display Usage entry.

What if the shared application executes another application?

When you share an application, any application that can be run from within that application can be 
shared in the same session.    (Once a session begins, you cannot start another session.)    For 
example, in most Windows applications you can launch online Help by pressing F1 or choosing a menu 



item from the Help menu.    Both the host and the guest can then read the Help.    While you are getting 
used to application sharing, consider carefully whether you want to start sharing a new application 
within the same session.

What happens if I share Program Manager?

When you share Program Manager, all applications open on the host's system are automatically shared 
as well (except the ProShare application).    While you are getting used to application sharing, consider 
carefully whether you want to share Program Manager.



 Uninstalling the ProShare software

The ProShare software includes an uninstall utility that deletes most of the software files installed and 
reverses system initialization information, such as the ProShare software capture driver.    The Uninstall 
program does not delete the subdirectory containing the ProShare software if you have saved or copied 
files into that directory.

The Uninstall program does not uninstall the Address Book or its data files (in case you are using the 
Address Book with other Intel applications).

The Uninstall program is unable to delete the ProShare program group if you are using a Windows shell 
program other than Program Manager.

To run the Uninstall program:

· Double-click the Uninstall icon in the ProShare program group.

To remove the Address Book files:

1. Change to your Windows directory, then change to the ICOMM directory.    From there, delete the 
ADDRBOOK directory and all the files it contains.

2. Change to your Windows directory.    Delete the ICOMMAB.INI file.

To remove the Intel Product Registration files:

· Change to your Windows directory, then change to the ICOMM directory.    From there, delete the 
AUTOREG directory and all the files it contains.





New command (File menu)

Clears the conference notebook.    If the current notebook contains unsaved information, the ProShare 
application prompts you to save it.



Open command (File menu)

Displays the Open dialog box so you can open an existing meeting file.    The public pages reside in a 
meeting file with a .MTG file extension; your private pages reside in a private file with the same name 
as the meeting file but with a .PRV file extension.    You can open a .PRV file only by opening a .MTG 
file with the same name.

To import a file in another format (from another application), use the Import command from the File 
menu.

When you open an existing meeting file, you can either replace any existing notebook information with 
the meeting file or merge the notebook with the meeting file.    Choose the Merge button to merge the 
information.    Choose the OK button to replace the information; if the notebook contains unsaved 
information, the ProShare application prompts you to save it.

____________
See also

Setting your notebook preferences



Import command (File menu)

Displays the Import dialog box so you can bring information into your conference notebook from a file 
created by another application.    Once you select the file to import and choose OK, you select the 
import method from the Import Using dialog box:

· Select a graphics file type that the ProShare application can convert to an annotation item in the 
notebook.    The available graphics formats include PCX, TIFF, BMP, DIB, TGA, and GIF.

· Select ASCII to bring an editable text annotation into the notebook.

· For other formats, import the file using the ProShare application's Print Capture option.    The 
application containing the file runs in the background while the file is printed into the notebook.

To open a meeting file (a notebook saved by the ProShare application), use the Open command from 
the File menu.



Save command (File menu)

Saves the contents of your notebook in a meeting file.    The public pages are saved in a meeting file 
with a .MTG file extension.    Your private pages are saved in a private file with the same name as the 
meeting file but with a .PRV file extension.    If you previously saved the conference, the ProShare 
application overwrites the file.    If the conference has not been saved, the ProShare application displays 
the Save As dialog box so you can specify a filename.

____________
Note

The annotations you make in your private pages are retained only in the .PRV file that you save.    The 
other participant does not have access to your private notes.

Once saved, the .MTG file can be opened in a later conferencing session for further discussion.    Once 
opened, the saved file is placed into the public pages of your notebook exactly as it was when you last 
saved it.



Save As command (File menu)

Displays the Save As dialog box so you can save the current notebook to a meeting file whose name 
you specify.    The public pages are saved in a meeting file with a .MTG file extension.    Your private 
pages are saved in a private file with the same name as the meeting file but with a .PRV file extension. 

____________
Note

The annotations you make in your private pages are retained only in the .PRV file that you save; the 
other participant does not have access to your private notes.

Once saved, the .MTG file can be opened in a later conferencing session for further discussion.    Once 
opened, the saved file is placed into the public pages of your notebook exactly as it was when you    last 
saved it.



Print command (File menu)

Displays the Print dialog box so you can print the notebook contents.



Print Setup command (File menu)

Displays the Print Setup dialog box so you can select a printer and configure it for printing.



Transfer command (File menu)

Displays the File Transfer dialog box so you can select one or more files to send to the other 
conference participant.    This command is available only after a connection has been established.

____________
See also

Transfer Status command



Transfer Status command (File menu)

Displays the File Transfer Status dialog box so you can monitor the progress of files being transferred 
to the other conference participant.    This command is available only when a transfer is in progress.



n filename command (File menu)

Opens the meeting file filename, if it exists.    This command is a shortcut for the Open command; if the 
notebook contains unsaved information, the ProShare application prompts you to save it.    This 
command does not merge filename with the current contents of the notebook.    The File menu displays 
up to four of the most recently opened or saved files.    The ProShare application retains the filenames 
and their paths in the PSDATA.INI file located in your WINDOWS subdirectory.



Exit command (File menu)

Exits the ProShare application.



Undo Delete Annotation or Undo Delete Page command (Edit menu)

Restores the most recently deleted annotation or most recently deleted page.    When the command is 
unavailable, it reads Can't Undo.

____________
See also

Cut command
Delete command
Delete - Public command
Delete - Private command



Cut command (Edit menu)

Removes the selected annotation from the notebook and places it on the Windows Clipboard, replacing 
the existing information on the Clipboard, if any.    This command is available only when an annotation 
in the notebook has been selected.    (To select an annotation, click on it with the selection pointer.)

____________
See also

Copy command
Delete command



Copy command (Edit menu)

Copies the selected annotation from the notebook and places it on the Windows Clipboard, replacing 
the existing information on the Clipboard, if any.    This command is available only when an annotation 
in the notebook has been selected.    (To select an annotation, click on it with the selection pointer.)

____________
See also

Cut command
Delete command



Paste - Public command (Edit menu)

Copies the contents of the Windows Clipboard onto the current public page of the notebook.    This 
command is available only when there is information on the Clipboard.

____________
See also

Paste - Private command
Paste Special command



Paste - Private command (Edit menu)

Copies the contents of the Windows Clipboard onto the current private page of the notebook.    This 
command is available only when there is information on the Clipboard.

____________
See also

Paste - Public command
Paste Special command



Paste Special command (Edit menu)

Displays the Paste Special dialog box so you can paste an annotation into the notebook and retain 
certain characteristics of the annotation.    This command is available only when there is information on 
the Windows Clipboard and the application that created the information supports this feature.

If you embed an OLE object in the notebook, you can double-click the OLE object (or choose the 
application-name   Object command   from the Edit menu) to view and edit the object in the application 
that originally created it.    OLE objects are available only from applications that support OLE.

To create an OLE object, see Embedding OLE information from another application.

____________
See also

Paste - Public command
Paste - Private command



Delete command (Edit menu)

Removes the selected annotation from the notebook without placing it on the Windows Clipboard.    This 
command is available only when an annotation in the notebook has been selected.    (To select an 
annotation, click on it with the selection pointer.)

This command is equivalent to the Clear command in many Windows applications.

____________
See also

Cut command
Copy command



Resize command (Edit menu)

Displays the Resize Annotation dialog box so you can make an annotation larger or smaller or change 
its proportions.    This command gives you more accurate control than resizing using the annotation 
handles.



Add Page - Public command (Edit menu)

Adds a new page to the notebook.    If the Link Public and Private Pages check box is deselected in the 
Preferences dialog box, only the public workspace receives a new page tab.

____________
See also

Add Page - Private command



Add Page - Private command (Edit menu)

Adds a new page to the private workspace.    This command is available only when the Link Public and 
Private Pages check box is deselected in the Preferences dialog box (the private workspace has tabs).

____________
See also

Add Page - Public command



Delete Page - Public command (Edit menu)

Deletes the current public page of the notebook, with the following exception:

· If the notebook only contains one public page with annotations, all annotations are cleared on that 
page, and the page remains in the notebook.

____________
Important tip

If the Link Public and Private Pages check box is selected in the Preferences dialog box (the private 
workspace does not have tabs), the Delete Page - Public command also appears to delete annotations 
in the private workspace.    However, if you subsequently select Link Public and Private Pages in the 
Preferences dialog box, those deleted annotations actually still exist on an independent private page 
(until you delete them individually or with the Delete Page - Private command).

If the notebook only contains one blank public page, this command is unavailable.

____________
See also

Delete Page - Private command



Delete Page - Private command (Edit menu)

Deletes the current page of the private workspace, with the following exception:

· If the notebook only contains one private page with annotations, all annotations are cleared on that 
page, and the page remains in the notebook.

If the notebook only contains one blank private page, this command is unavailable.

____________
See also

Delete Page - Public command



Synchronize Pages command (Edit menu)

Moves the other participant to the same notebook page that you are viewing.    Other ways of 
synchronizing pages are as follows:

· Double-click a tab on the right of the notebook to synchronize pages with the other participant (that 
is, move both you and the other participant to that page).

· Double-click the page number of the other participant in the Attendee Status bar to jump to that 
same page.



application-name Object command (Edit menu)

Starts the application that originally created the selected OLE object and opens the object for editing.    
The name of this command changes to show the application name of the selected object.    This 
command is equivalent to double-clicking the OLE object in the notebook.    This command is available 
only when an OLE object is selected.    When the command is unavailable (that is, an OLE object is not 
selected), it reads Object.







Data Tools command (View menu)

Toggles the Data Capture toolbox on and off.    This toolbox contains snapshot tools for taking a picture 
of portions of your screen along with buttons equivalent to the commands on the Application menu.    
You also can bring information into the notebook by using the Import command from the File menu or 
by using a Paste command from the Edit menu.

____________
See also

Import command Share Application View command
Paste - Public command Host and Guest Edit or Only Host Edits command
Paste - Private command Stop Sharing Application command
Paste Special command





Annotation Tools command (View menu)

Toggles the Annotation toolbox on and off.    This toolbox contains marking tools and pointers for 
annotating information in the notebook.



Page Sorter command (View menu)

Opens and closes the Page Sorter dialog box.



Full Screen command (View menu)

Toggles the main notebook between a window and a full screen without menus displayed.    Full screen 
mode is useful when making presentations at a conference or for viewing a larger portion of a notebook 
page.    Note that full screen mode is not the same as maximizing the window.    To exit from full screen 
mode, press F7 or Escape.    The shortcut keys are available in full-screen mode, for example, the F5 
key toggles the Annotation toolbox on and off, and the F2 key toggles the Data Capture toolbox on and 
off.



Private Workspace command (View menu)

Opens and closes the private workspace at the bottom of the notebook.    You can use this area to make 
notes that you don't want to share with the other participant.



Preferences command (View menu)

Displays the Preferences dialog box so you can set options such as notebook tabs, spiral, and status 
bars.



Selection Pointer command (Toolbox menu)

Chooses the selection pointer tool  from the Annotation toolbox.    Your cursor becomes a pointer 
with which you can select an annotation in the notebook page before you move, copy, resize, or delete 
it.



Commands for configurable tools (Toolbox menu)

Remote Pointer changes your cursor into a pointer that the other participant can see when you hold 
down the left mouse button.    To ensure that each participant's pointer is unique and 
recognizable, at least one participant should double-click the remote pointer tool and 
change its color in the Configure Remote Pointer dialog box.

Highlighter changes your cursor into a highlighter so you can color over any area in the notebook.

Pen tool changes your cursor into a pen so you can write in the notebook.

Text tool changes your cursor into an I-beam so you can select a location in the notebook and 
type text at that location.

Rectangle changes your cursor into a square so you can create rectangles or squares in the 
notebook.    (To create squares, press and hold the Shift key while dragging.)

Ellipse changes your cursor into a circle so you can create ellipses or circles in the notebook. 
(To create circles, press and hold the Shift key while dragging.)

Line changes your cursor into a dot so you can draw straight lines in the notebook.

You can configure any of these tools with the Configure Tool or Configure Remote Pointer command 
(from the Toolbox menu) or by double-clicking the tool.



Remote Pointer command (Toolbox menu)

Chooses the remote pointer  from the Annotation toolbox.    Your cursor becomes a pointer that the 
other participant can see when you hold down the left mouse button.    Then you can point out 
annotations in the notebook as you discuss them.    You can configure the remote pointer's color with 
the Configure Remote Pointer command or by double-clicking the tool in the Annotation toolbox.



Highlighter command (Toolbox menu)

Chooses the corresponding highlighter  from the Annotation toolbox.    Your cursor becomes a 
highlighter with which you can color over any area in the notebook.    You can configure a highlighter 
tool with the Configure Tool command or by double-clicking on the tool in the Annotation toolbox.



Pen command (Toolbox menu)

Chooses the corresponding pen  from the Annotation toolbox.    Your cursor becomes a pen with 
which you can write and draw lines in the notebook.    You can configure a pen tool with the Configure 
Tool command or by double-clicking on the tool in the Annotation toolbox.



Text command (Toolbox menu)

Chooses the corresponding text tool  from the Annotation toolbox.    Your cursor becomes an I-
beam with which you can select a location in the notebook and then type text at that location.    You can 
configure a text tool with the Configure Tool command or by double-clicking on the tool in the 
Annotation toolbox.



Rectangle command (Toolbox menu)

Chooses the corresponding rectangle tool  from the Annotation toolbox.    Your cursor becomes a 
square with which you can draw rectangles or squares.    Position the mouse at one corner of the 
rectangle and drag to the diagonally opposite corner.

To draw a square, press and hold the Shift key as you drag the mouse.    You can configure a rectangle 
tool with the Configure Tool command or by double-clicking on the tool in the Annotation toolbox.



Ellipse command (Toolbox menu)

Chooses the corresponding ellipse tool  from the Annotation toolbox.    Your cursor becomes a 
circle with which you can draw ellipses or circles.    Position the mouse at one corner of the ellipse and 
drag to the diagonally opposite corner.

To draw a circle, press and hold the Shift key as you drag the mouse.    You can configure an ellipse tool 
with the Configure Tool command or by double-clicking on the tool in the Annotation toolbox.



Line command (Toolbox menu)

Chooses the corresponding straight line tool  from the Annotation toolbox.    Your cursor becomes a 
dot with which you can draw straight lines.    To draw a horizontal, vertical, or 45 degree lines, press and 
hold the Shift key as you drag the mouse.    You can configure a line tool with the Configure Tool 
command or by double-clicking on the tool in the Annotation toolbox.



Configure Tool or Configure Remote Pointer command (Toolbox menu)

Displays the Configure Tool dialog box so you can set the size and color of the marking tools.    If the 
remote pointer is selected, this command displays the Configure Remote Pointer dialog box so you can 
change the color of the remote pointer.    The lower six tools in the Annotation toolbox can be any 
combination of highlighters, pens, text tools, rectangles, ellipses, or straight lines.    This command is 
available only when a configurable tool is selected; if the selection pointer is the current tool, this 
command is unavailable.



Connect command (Conference menu)

Displays the Connect dialog box so you can connect with a colleague to start a conference.    This 
command is unavailable when you are connected to a conference.



Disconnect command (Conference menu)

Breaks the telephone or the network connection, ending the conference.    This command is unavailable 
if you are not connected to a conference.





Address Book command (Conference menu)

Opens the Intel Address Book where you can define or modify additional information for connecting with 
a colleague.    You also can open the Address Book by double-clicking its icon in the ProShare program 
group.

When you add, modify, or remove a participant in the Connect dialog box, the information is stored in 
the Address Book.





Setup command (Conference menu)

Displays the Conference Setup dialog box so you can set up network and modem connection 
preferences.



Jump Start command (Conference menu)

Displays the Jump Start dialog box so you can send a working version of the ProShare software to a 
colleague.    Then you can conduct conferences before your colleague purchases the Intel ProShare 
Personal Conferencing software.    This command is unavailable when you are connected to a 
conference.





Share Application View command (Application menu)

Displays the Share Application View dialog box so you can start sharing an application that is running 
on your system.    In this mode, you share an actual application and its data with the other participant 
instead of sharing information in the notebook.    The host of the application determines whether the 
guest can edit information displayed in the shared application.    This command is available only after a 
connection has been established.



Host and Guest Edit or Only Host Edits command (Application menu)

Toggles the guest between view-and-edit mode and view-only mode for application sharing.    Only the 
host of the shared application can choose these commands.    The commands are available only after 
application sharing has been started.



Stop Sharing Application command (Application menu)

Closes the shared application and stops application sharing.    Either the host or guest can choose this 
command.    This command is available only after application sharing has been started.





Contents command (Help menu)

Displays the main contents screen of the ProShare application's Help.



Search for Help On command (Help menu)

Displays the Search dialog box so you can find specific information in the Help.    For more information 
on this dialog box, see Searching in Help.



How to Use Help command (Help menu)

Displays the first of eight topics that explain how to use Help.



Tutorial command (Help menu)

Displays a meeting file that describes much of the functionality of the ProShare application.



About command (Help menu)

Displays the About dialog box which shows the ProShare application's version number and copyright 
information.

____________
Tip

Click the mouse in the copyright information area.    Continue to click the mouse to see your connection 
information, such as network address.



New Page command (Data Capture pop-up menu)

Pastes the snapshot you have taken into the notebook on a new page.    This command is available 
after you choose the camera or crop tool.



Current Page command (Data Capture pop-up menu)

Pastes the snapshot you have taken into the notebook on the current page.    This command is 
available after you choose the camera or crop tool.



New Private Page command (Data Capture pop-up menu)

Pastes the snapshot you have taken into the notebook on a new private page.    This command is 
available after you choose the camera or crop tool.    This command is unavailable when the private 
pages are linked with the public pages.

____________
See also

Setting your notebook preferences



Current Private Page command (Data Capture pop-up menu)

Pastes the snapshot you have taken into the notebook on the current private page.    This command is 
available after you choose the camera or crop tool.



Quit Snapshot command (Data Capture pop-up menu)

Cancels the snapshot action.    The snapshot is not pasted into the notebook.    This command is 
available after you choose the camera or crop tool.



 Open dialog box

The Open dialog box opens when you choose the Open command from the File menu.    Use this dialog 
box to open an existing meeting file (.MTG extension) and its corresponding private pages file (.PRV 
extension), if any.    (To import information from a file created by another application, use the Import 
command.)

Click on an area for information.

To open a meeting file:

1. Select the drive containing the file.

2. Select the directory containing the file.

3. Select the file from the list or enter the filename in the text entry box.    The default file type 
extension is .MTG.    Note that you cannot open a private pages file directly; you must open the 
corresponding .MTG file, and the private pages load automatically.

4. Choose OK.    The ProShare application prompts you to save any unsaved work before it places the 
new file in the notebook.

To merge a meeting file with the present conference notebook:

1. Select the drive containing the file.

2. Select the directory containing the file.

3. Select the file from the list or enter the filename in the text entry box.    The default file type 
extension is .MTG.

4. Choose Merge.    Starting with page 1, if a page in the current notebook matches a page in the file 
to be merged, only one of these pages is retained.    All unique pages in the file to be merged are 
appended to the notebook.

____________
Important tip

Annotations on the first page of each participant's notebook are merged onto the same page under the 
following circumstances:

1. Participants are connected, one or both executes the New command from the File menu, then the 
participants disconnect.

2. Both disconnected participants make annotations on their first notebook pages.



3. Both participants choose to have the notebooks merged (see the Connection Merge Controls in the 
Preferences dialog box).

4. The participants re-connect to each other.

____________
See also

Bringing information into the notebook

Setting your notebook preferences



File Name list (Open dialog box)

Select the file from the list or enter the filename in the text entry box.    You can filter the files that appear 
in the list by entering a wildcard filename in the text entry box.    Note that you cannot open a private 
pages file directly; you must open the corresponding .MTG file, and the private pages load 
automatically.



List Files of Type list (Open dialog box)

Select a file type from the drop-down list.    The default file type extension is .MTG.



Directories list (Open dialog box)

Select the directory containing the file.



Drives list (Open dialog box)

Select the drive containing the file.



Merge button (Open dialog box)

Choose the Merge button to open a ProShare application meeting file (.MTG extension) and to merge 
the pages with the current notebook.



 Import dialog box

The Import dialog box opens when you choose the Import command from the File menu.    Use this 
dialog box to import a file created by another application.    Each page of imported information becomes 
a bitmap in the ProShare application notebook; you can mark on it, move it, or delete it, but you cannot 
edit it.

Click on an area for information.

To import a file:

1. Select the drive containing the file.

2. Select the directory containing the file.

3. Select the file from the list or enter the filename in the text entry box.

4. Choose OK to display the Import Using dialog box, then select the method used to import the file.

____________
See also

Bringing information into the notebook



File Name list (Import dialog box)

Select the file from the list or enter the filename in the text entry box.    You can filter the files that appear 
in the list by entering a wildcard filename in the text entry box.



List Files of Type list (Import dialog box)

Select a file type from the drop-down list.



Directories list (Import dialog box)

Select the directory containing the file.



Drives list (Import dialog box)

Select the drive containing the file.



 Import Using dialog box

The Import Using dialog box opens when you select a file and choose OK in the Import dialog box.    
Use this dialog box to select the type of the file you are importing.    For graphics files and ASCII text 
files, the ProShare application imports the image or text directly onto a new notebook page.    For other 
file types, the ProShare application opens the application that originally created the file and prints the 
file into the notebook using the ProShare application's print capture driver.    Each page of imported 
information becomes a bitmap in the ProShare application notebook; you can mark on it, move it, or 
delete it, but you cannot edit it.

Click on an area for information.

To import a file:

1. If you're importing a graphics file, select its type. If you're importing an ASCII text file, select that 
option. Otherwise select Print Capture.    (If you're unsure whether the file is a graphics file, or the 
graphics file type is not in the list, select Print Capture.)

2. Choose OK.

____________
See also

Bringing information into the notebook



Import using list (Import Using dialog box)

If you're importing a graphics file, select its type. If you're importing an ASCII text file, select that option. 
Otherwise select Print Capture.



 Save As dialog box

The Save As dialog box opens when you choose the Save As command from the File menu, or when 
you save the notebook (meeting file) for the first time.    Use this dialog box to specify a name and 
location for your saved meeting file.

Information from the public workspace is saved in the meeting file you designate.    Information from the 
private workspace is saved in a file with the same filename, but with the .PRV extension.

Click on an area for information.

To save a meeting file:

1. Select the drive that will contain the file.

2. Select the directory that will contain the file.

3. Enter the filename in the text entry box (or select a filename from the list, if you wish to overwrite a 
file).    The default file type extension is .MTG.    The ProShare application reserves .PRV as the file 
type extension for private pages.

4. Choose OK.



File Name list (Save As dialog box)

Enter the filename in the text entry box or select a file from the list.    You can filter the files that appear 
in the list by entering a wildcard filename in the text entry box.    The ProShare application 
reserves .PRV as the file type extension for private pages (but you cannot open a .PRV file separately).



Save File as Type list (Save As dialog box)

Select a file type from the drop-down list.    The default file type extension is .MTG.



Directories list (Save As dialog box)

Select the directory containing the file.



Drives list (Save As dialog box)

Select the drive containing the file.



 Print dialog box

The Print dialog box opens when you choose the Print command from the File menu.    Use this dialog 
box to print notebook pages to your printer or to a file.

(For information on the print capture driver that you use when printing from another application directly 
into the ProShare application notebook, see Setting up the print capture driver.)

Click on an area for information.

To print:

1. Check the printer named at the top.    To specify another printer, choose the Setup button to open 
the Print Setup dialog box, and close the Print Setup dialog box when you're finished.

2. From the Print selections, select Public to print pages from the public workspace.

or

Select Private to print pages from the private workspace.    In a linked notebook (where private 
pages are an extension to the public pages), Private pages are printed after their corresponding 
public pages.    In an independent notebook (where private pages are independent of the public 
pages), private pages are printed after all public pages have been printed.

or

Select Both to print pages from both workspaces.

3. From the Print Range selections, select the desired pages:

To print all pages, select All.

To print one page, select Pages and then enter the page number in both the From box and the To 
box.

To print several pages in a row, select Pages and then enter the page number of the first page to 
print in the From box, and the page number of the last page to print in the To box.



4. Select the desired Print Quality.    "dpi" means dots per inch.    The higher the value, the better the 
quality output.    On some systems, this control reads High, Medium, or Draft instead of dpi.    The 
list contains settings supported by the printer named at the top.

5. From the Scaling selections, select the desired scaling:

To scale notebook pages to fit on a printed page, select Scale to Page.    The ProShare application 
examines the pages and scales the largest notebook page to fit on a printed page, then applies the 
same scale factor to all other pages.

To print each page as it appears on the screen, select Reduce/Enlarge to 100%.    (Note that if a 
notebook page contains more information than can fit on a printed page, the information runs off the 
edge of the printed page.)

To print each page reduced or enlarged by the same factor, select Reduce/Enlarge and enter the 
scaling factor.    Values greater than 100% make the items on a notebook page look larger; values 
less than 100% reduce the size of the items.

6. Enter the number of copies to print.

7. Select Collate Copies if you are printing multiple copies and you want each copy of the notebook to 
finish printing before the next copy is printed.    Deselect Collate Copies if you want all copies of the 
first page to print together, all copies of the second page, and so on.

8. Select Print to File if you want to create a print file rather than send the output directly to a printer.    
When you choose OK in step 10, the Print to File dialog box appears and prompts you to enter the 
filename.    (You can precede the filename with drive and path designations; otherwise the file is 
saved to your current directory, which is probably the ProShare application's directory.)    Later you 
can copy the file to the printer.

9. Select Include Page Numbers if you want page numbers printed at the bottom of each page.

10. Choose OK.



Printer designation (Print dialog box)

Shows the current printer.    To change the printer, choose the Setup button to open the Print Setup 
dialog box.



Print Range buttons and page numbers (Print dialog box)

Specify printing all the pages, one page, or a range of pages.



Print Quality list (Print dialog box)

Set the quality of the printer output.



Print to File check box (Print dialog box)

Select this box to print to a file.    When you choose OK, the Print to File dialog box appears and 
prompts you to enter the filename.



Print buttons (Print dialog box)

Specify printing the public pages, the private pages, or both.



Scaling buttons and percentage value (Print dialog box)

You can set up your printer to scale the contents of each notebook page to a particular paper size or 
you can reduce or enlarge the page contents according to the percentage you set.



Copies value (Print dialog box)

Enter the number of copies you want to print.



Collate Copies check box (Print dialog box)

Select this checkbox if you are printing multiple copies and you want each copy of the notebook to 
finish printing before the next copy is printed.    Deselect this check box if you want all copies of the first 
page to print together, all copies of the second page, and so on.



Include Page Numbers check box (Print dialog box)

Select this box to include page numbers at the bottom of printed pages.



Setup button (Print dialog box)

Choose this button to open the Print Setup dialog box and select a different printer.



 Print Setup dialog box

The Print Setup dialog box opens when you choose the Print Setup command from the File menu, or 
the Setup button in the Print dialog box.    Use this dialog box to specify the printer that prints your 
notebook.

(For information on the print capture driver that you use when printing from another application directly 
into the ProShare application notebook, see Setting up the print capture driver.)

Click on an area for information.

To select a printer:

1. Select the Default Printer.

or

Select Specific Printer and select a printer from the drop-down list of available printers.

2. Set the orientation of the paper:    Portrait is taller than wide, and Landscape is wider than tall.

3. Select the correct paper size and source from the drop-down lists.

4. Optionally, choose the Options button to open the Options dialog box and to set more printer 
settings.

5. Choose OK.



Printer buttons and list (Print Setup dialog box)

Select the Default Printer or specify a different printer from the drop-down list of available printers.



Orientation buttons (Print Setup dialog box)

Set the orientation of the paper:    Portrait is taller than wide, and Landscape is wider than tall.



Paper Size and Source lists (Print Setup dialog box)

Select the correct paper size and source from the drop-down lists.



Options button (Print Setup dialog box)

Choose the Options button to set more printer settings.



 File Transfer dialog box

The File Transfer dialog box opens when you choose the Transfer command from the File menu.    Use 
this dialog box to select and transfer one or more files to the other participant.    The file transfer process 
occurs in the background, so that participants can continue using other conferencing features.

Click on an area for information.

To transfer a file:

1. Select the drive containing the file(s).

2. Select the directory containing the file(s).

3. Select one or more files from the list.    Use Shift+Click to select multiple consecutive files, or 
Ctrl+Click to select multiple non-consecutive files.    Or you can enter the filenames (including 
pathnames) in the text entry box, separated by spaces.

4. Choose OK.

____________
See also

Transferring files



File Name list (File Transfer dialog box)

Select the file from the list or enter the filename in the text entry box.    You can filter the files that appear 
in the list by entering a wildcard filename in the text entry box.



List Files of Type list (File Transfer dialog box)

Select a file type from the drop-down list.



Directories list (File Transfer dialog box)

Select the directory containing the file.



Drives list (File Transfer dialog box)

Select the drive containing the file.



 File Transfer Status dialog box

The File Transfer Status dialog box opens when you choose the Transfer Status command from the File 
menu.    Use this dialog box to monitor the status of files being transferred or to terminate transferring a 
file.

Click on an area for information.

To terminate transferring a file:

1. From the File Transfers in Progress list, select the file.

2. Choose Abort.

____________
See also

Transferring files



File Transfers in Progress list (File Transfer Status dialog box)

The list of files being transferred.



Transfer details (File Transfer Status dialog box)

The status of the files being transferred.



Abort button (File Transfer Status dialog box)

To stop transferring a file, select a file from the File Transfers in Progress list, then choose Abort.



 File Transfer Receipt dialog box

The File Transfer Receipt dialog box opens when the other participant sends a file to you.    Use this 
dialog box to name the file and save it on your system.

Click on an area for information.

To save a transferred file:

1. Select the drive that will contain the file.

2. Select the directory that will contain the file.

3. Select the Overwrite Old Files check box if you want to replace files with the same name.    
Otherwise a dialog box prompts you for a new name for any duplicate filename.

4. Choose OK.

____________
See also

Transferring files



Incoming Files list (File Transfer Receipt dialog box)

The list of files being transferred.



Directories list (File Transfer Receipt dialog box)

Select the directory that will contain the file.



Drives list (File Transfer Receipt dialog box)

Select the drive that will contain the file.



Overwrite Old Files check box (File Transfer Receipt dialog box)

Select this check box if you want to replace files with the same name.



 Paste Special dialog box

The Paste Special dialog box opens when you choose the Paste Special command from the Edit menu. 
Use this dialog box to choose a format for the information you are pasting.    This dialog box shows the 
application that created the information inside the Windows Clipboard; it also lists one or more formats 
available for that information.    The application Object format embeds an object that remembers its 
originating application (and can be edited later).    Once you place an OLE object in the notebook, you 
can double-click the item (or choose the object from the Edit menu), and can edit the information in its 
originating application.    The changes you make to an OLE object will be reflected in the notebook.

Note that the application Object format (OLE) is not available in the Jump Start version of the ProShare 
software.

Click on an area for information.

To paste an object:

1. To paste an OLE object, select the format labeled application Object from the list, where application 
is the name of the application from which you copied.

or

To paste an object using another format, select the appropriate format from the list.

2. To embed the object on the current public page, choose Paste.

or

To embed the object on the current private page, choose Paste Private.

3. The ProShare application puts the object in the upper left corner of the notebook page.    (The 
information is just another annotation.)    Making annotations in the notebook describes how to 
move the object.

Usually the information itself appears on the page in the notebook.    However, some applications 
represent the linked information with an icon, which appears on the notebook page.

____________
See also

Bringing information into the notebook

Embedding OLE information from another application



Source application (Paste Special dialog box)

Displays the source application that created the information inside the Clipboard.



Data Type list (Paste Special dialog box)

Select the format for the object that you are linking.    An object on the Clipboard can have several of the 
formats listed here.    The application Object format embeds an object that remembers its originating 
application (and can be edited later).



Paste and Paste Private buttons (Paste Special dialog box)

Choose the Paste button to place the object in the public workspace in the notebook.    Usually the 
information itself appears on the page in the notebook.    However, some applications represent the 
linked information with an icon, which appears on the notebook page.

Choose Paste Private to paste to the private workspace in the notebook.



 Resize Annotation dialog box

The Resize Annotation dialog box opens when you choose the Resize command from the Edit menu.    
Use this dialog box to stretch, collapse, or reset the size of the currently selected annotation.

Click on an area for information.

To stretch or collapse an annotation horizontally:

· Increase or decrease the Width value either by pressing the up or down arrow control or by 
entering a different value into the edit box.    Fractional values are truncated.    You do not have to 
enter the % character.

To stretch or collapse an annotation vertically:

· Increase or decrease the Height value either by pressing the up or down arrow control or by 
entering a different value into the edit box.    Fractional values are truncated.    You do not have to 
enter the % character.

To retain the same proportions while stretching or collapsing:

· Ensure that the Width and Height values match.    Fractional values are truncated.

To reset an annotation to its original size:

· Set the Width and Height values to 100%.



Scaling values (Resize Annotation dialog box)

Increase or decrease the values either by pressing the up or down arrow control or by entering a 
different value into the edit box.    Fractional values are truncated.    You do not have to enter the % 
character.



 Page Sorter dialog box

The Page Sorter dialog box opens when you choose the Page Sorter command from the View menu.    
Use this dialog box to view thumbnail-sized images of the notebook pages and to move pages around 
in the notebook.    You can leave this dialog box open for quick reference while you perform other tasks.

Click on an area for information.

To view private pages:

· Select the Private Pages check box.

To select a group of pages:

· Either select each page by using Ctrl+Click, or select a range of pages by using Shift+Click to 
specify both the starting page and the ending page.    You can then move, reorder, delete, or print 
the pages as a group.

To move a page:

· Click and drag the page so that its outline is slightly to the left of what will be the next page.    Note 
that you cannot move a public page to the private workspace, or vice versa.

To delete a page:

· Select the page and choose Delete.

or

Click and drag the page to the Delete button.

To print a page:

· Select the page and choose Print.

or

Click and drag the page to the Print button.

To print more than one copy of a page at a time, from the File menu in the main window, choose the 
Print command.

To jump to a page in the notebook:

· Double-click on the page.

____________



See also

Moving around in the notebook



Page thumbnail list (Page Sorter dialog box)

Page numbers correspond to the page tab in the notebook.    Use the scrolling bar to see the pages that 
are not showing.



Print and Delete buttons (Page Sorter dialog box)

Select a page from the thumbnails and choose Print or Delete.    You can also drag a page to the Print 
or Delete button.



Private Pages check box (Page Sorter dialog box)

Select this box to display thumbnails of the private pages instead of the public pages.



 Preferences dialog box

The Preferences dialog box opens when you choose the Preferences command from the View menu.    
Use this dialog box to set up your ProShare application's notebook and some miscellaneous controls.

Click on an area for information.

To set your graphics display preferences:

1. Select the number of colors to use when displaying graphical images.    (Selections that are gray 
are unavailable for your video display.)    Selecting 256 Colors, if available, results in the optimal 
performance during data transmission.    However, if the other conference participant is limited to 16 
colors (VGA), selecting 16 Colors ensures that images display the same on both of your systems.

Note that if you import graphical information from a file other than the graphics types in the Import 
Using dialog box, the ProShare print capture driver is limited to importing in 16 colors.    To capture 
an image with more than 16 colors (and its file type is not one of those listed in the Import Using 
dialog box), open the image in its parent application, and then take a snapshot of the image using 
the Data Capture toolbox.

2. Deselect Use JPEG Compression to obtain the best resolution of images.    When on, the 
information shared in the notebook is compressed before transferring it between participants.    As a 
result, the data transmission is faster but the resolution of the image is not as good.    If you and 
your colleague are connected over a high-speed network and you are sharing high-resolution 
images, you can deselect JPEG compression to obtain the best resolution of images.

3. Set other preferences or choose OK.

To define the private workspace as a separate notebook:

1. Select Link Public and Private Pages to make your private workspace an extension of the public 
workspace.    Deselect Link Public and Private Pages if you want a separate private notebook (with 
separate page numbers).

2. Set other preferences or choose OK.

To make the Annotation toolbox an independent, floating window:

1. Select Float Annotation Tools to change the Annotation toolbox to a floating sub-window.    Note that 
you cannot move the Annotation toolbox outside of the workspace window; whereas the Data 
Capture toolbox floats anywhere on the top of your screen.



2. Set other preferences or choose OK.

To set other characteristics of the notebook environment:

1. Select Attendee Status to display the Attendee status bar above the conference notebook, lists both 
conference participants, and their current notebook pages.

2. Select Status Bar to display the status bar below the conference notebook.

3. Select Tab Bar to display page tabs for the public and private workspaces.    If you select the Link 
Public and Private Pages check box, the private workspace is an extension of the public workspace 
page.    If the Link Public and Private Pages check box is deselected, the private workspace has its 
own tabs and acts like an independent notebook.

4. Deselect Spiral and Border to remove the notebook-like image and make more space on the 
notebook page.

5. Deselect Private Title Bar to make more space on the notebook page.    (The title bar is a separator 
between the public and private workspace to remind you that the private workspace is open.)

6. Set other preferences or choose OK.

To set your own name and how names are displayed:

1. Choose the Names button to open the Names dialog box.    Specify your name (as displayed by the 
application) and how names are displayed, and close the Names dialog box when you're finished.

2. Set other preferences or choose OK.

To receive notification of incoming connections:

1. Select Enable Call Screening to have the ProShare application display a message whenever an 
incoming connection is detected.    This method lets you reject a connection.

2. Set other preferences or choose OK.

To specify how an open meeting file will be handled at connection:

1. Select Merge Files on Connection to always merge the contents of the other participant's notebook 
with whatever you have in your notebook when a new connection is made.    This method makes 
your notebook immediately available to the other participant.

or

Select Close File on Connection to always close the notebook you have open when a new 
connection is made.    This method prevents the other participant from seeing the contents of your 
notebook until you specifically re-open the meeting file.

or

Select Prompt on Connection to cause the ProShare application to display a message asking 
whether to merge both participants' notebooks or close your notebook when a new connection is 
made.    This method lets you choose whether to make your notebook immediately available or not 
with each new connection.

2. Set other preferences or choose OK.

____________
Important tip

Annotations on pages of each participant's notebook (even if different) are merged onto the same page 
under the following circumstances:

1. Participants are connected, then the participants disconnect.

2. Either or both disconnected participants make annotations on existing notebook pages.

3. Both participants specify to have the notebooks merged.



4. The participants re-connect to each other.    Annotations are merged on pages that carry the same 
internal identification number.

____________
See also

Setting your notebook preferences

Setting your connection preferences for incoming connections



Display Graphics Using buttons (Preferences dialog box)

Selects the number of colors to use when displaying graphical images.    (Selections that are gray are 
unavailable for your video display.)    Selecting 256 Colors, if available, results in the optimal 
performance during data transmission.    However, if the other conference participant is limited to 16 
colors (VGA), selecting 16 Colors ensures that images display the same on both of your systems.



Display Controls check boxes (Preferences dialog box)

Toggle the characteristics of the notebook environment on and off.    The Attendee status bar displays 
above the conference notebook, and lists both conference participants and their current notebook 
pages.    The status bar displays below the conference notebook.

Deselect Spiral and Border and Private Title Bar to make more space on the notebook page.    (The title 
bar is a separator between the public and private workspace to remind you that the private workspace 
is open.)

The Tab Bar displays page tabs for the public and private workspaces    If you select the Link Public and 
Private Pages check box, the private workspace is an extension of the public workspace page.    If the 
Link Public and Private Pages check box is deselected, the private workspace has its own tabs and 
acts like an independent notebook.



Link Public and Private Pages check box (Preferences dialog box)

Check this box to make the private workspace an extension of the public workspace.    If the Link Public 
and Private Pages check box is not selected, the private workspace has its own tabs and acts like an 
independent notebook.



Use JPEG Compression check box (Preferences dialog box)

Toggles JPEG compression on and off.    When on, the information shared in the notebook is 
compressed prior to transferring it between participants.    As a result, the data transmission is faster but 
the resolution of the image is not as good.    If you and your colleague are connected over a high-speed 
network and you are sharing high-resolution images, you can deselect JPEG compression to obtain the 
best resolution of images.



Float Annotation Tools check box (Preferences dialog box)

Toggles the annotation tools between a fixed position on the left side of the notebook window and a 
floating position.    Note that you cannot move the floating Annotation toolbox outside of the workspace 
window; however, the Data Capture toolbox floats anywhere on top of your screen.



Connection Merge Controls buttons (Preferences dialog box)

Select Merge Files on Connection to merge the contents of the other participant's notebook with 
whatever you have in your notebook when a new connection is made.    This method makes your 
notebook immediately available to the other participant.

Select Close File on Connection to close the notebook you have open when a new connection is made. 
This method prevents the other participant from seeing the contents of your notebook until you 
specifically re-open the meeting file.

Select Prompt on Connection to cause the ProShare application to display a message asking whether 
to merge both participants' notebooks or close your notebook when a new connection is made.    This 
method lets you choose whether to make your notebook immediately available or not with each new 
connection.



Enable Call Screening check box (Preferences dialog box)

Select Enable Call Screening to have the ProShare application display a message whenever an 
incoming connection is detected.    This method lets you reject a connection.



Names button (Preferences dialog box)

Opens the Names dialog box for specifying your name and how names are displayed.



 Names dialog box

The Names dialog box opens when you choose the Names button in the Preferences dialog box.    Use 
this dialog box to set the name and the way it is displayed in the Attendee status bar.    The name that 
you enter here is the name that will be used as your address when connecting over a NetBIOS network.

Click on an area for information.

To set your preferences:

1. Enter your first and last name the way you want the ProShare application to display them.    Note 
that your name and the name of the other participant in a conference must be different.    Note also 
that changing your name in this dialog box does not affect the name displayed in the ProShare 
application's About dialog box.

2. Select the First Last or Last, First button to specify how names appear on the Attendee status bar, 
in the Participant Name list of the Connect dialog box, and in other places throughout the ProShare 
application.

____________
See also

Setting your notebook preferences

Using special conferencing features



Your Name text boxes (Names dialog box)

Enter your first and last name the way you want them to appear on the Attendee status bar.    When you 
connect with someone, the Attendee status bar displays the names of both participants.



Display Names As buttons (Names dialog box)

Select First Last or Last, First to control how names appear on the Attendee status bar, in the 
Participant Name list of the Connect dialog box, and other places throughout the ProShare application.



 Configure Tool or Configure Remote Pointer dialog box

The Configure Tool or Configure Remote Pointer dialog box opens when you choose the Configure Tool 
or Configure Remote Pointer command from the Toolbox menu, or when you double-click a 
configurable tool in the Annotation toolbox.    Use this dialog box to specify the tool type, color, size, and 
other attributes of the currently selected tool.

You can create any six tools that you want, in any order in the toolbox; for example, one text tool, two 
highlighters, one ellipse, one rectangle, and one straight line (no pen).

To make each participant's marks distinct, participants can agree on who will use which colors.

The following picture shows the Configure Tool dialog box for a text tool.    The pen, highlighter, 
rectangle, ellipse, and straight line tools use a similar dialog box.

Click on an area for information.

To configure a pen, highlighter, text, or straight line tool:

1. From the Tool Type buttons, select Pen, Highlighter, Text, or Line.

2. From the Color palette, select a color.

3. For a Text tool, select the point size and whether or not the text should be bold or italic.    Point size 
is a measure of how tall the characters are--the larger the number, the taller (and proportionately 
larger) the characters.    The text in this paragraph is 10-point. (Note that you cannot change the 
font.)

For a Highlighter, Pen, or Line tool, select the line width.    The line width is measured similar to 
point size.    The larger the number, the thicker the line.

For a Line tool, select whether or not the line is transparent.    When a straight line tool is 
transparent, it acts like a highlighter that always draws straight lines.

4. Choose OK.    Notice that the tool button that was active when you entered these changes now 
matches your new specifications.

To configure a rectangle or ellipse tool:



1. From the Tool Type buttons, select Rectangle or Ellipse.

2. Select or deselect the Transparent check box to indicate whether the rectangles or ellipses will be 
transparent or opaque.    If you select the Transparent check box, you are limited to four transparent 
colors.

3. From the Color palette, select a color.

4. Select or deselect the Fill check box to indicate whether the rectangles or ellipses will be filled or 
hollow.

5. Choose OK.    Notice that the tool button that was active when you entered these changes now 
matches your new specifications.

____________
Tip

To create a square or circle with the rectangle or ellipse tool, press and hold the Shift key while 
dragging the mouse.

The following picture shows the Configure Tool dialog box for the remote pointer.

Click on an area for information.

To configure the remote pointer:

1. Select the color.    To make each participant's remote pointer distinct, each participant can choose a 
different color.

2. Choose OK.

____________
See also

Setting your notebook preferences



Tool picture (Configure Tool dialog box)

The currently selected tool in the Annotation toolbox will have this picture on it.    (The picture varies 
depending on the characteristics you've set.



Tool Configuration selections (Configure Tool dialog box)

Specify the color, size, and other attributes for the active tool.    For example, if a text tool is active, you 
can specify the typeface as plain, bold, or italic.    If a rectangle, ellipse, or straight line tool is active, you 
can specify whether the annotation will be transparent.



Tool Type buttons (Configure Tool dialog box)

Select the tool type.    The lower six tools in the Annotation toolbox can be any combination of 
highlighters, pens, text tools, rectangle tools, ellipse tools, or straight line tools.



Remote pointer color (Configure Remote Pointer dialog box)

Select the color for the remote pointer tool.



Remote pointer picture (Configure Remote Pointer dialog box)

The remote pointer tool button has this picture in the Annotation toolbox.







 Connect dialog box

The Connect dialog box opens when you choose the Connect command from the Conference menu.    
Use this dialog box to define, select, and connect to another participant.    You also can initiate a 
connection directly from the Address Book.

The following picture shows the Connect dialog box when connecting over a modem.    When 
connecting over a network, the connection information reflects the different method.

Click on an area for information.

When connecting over a modem, the participant's phone number is displayed, if you already have entered 
it.    To define or change the phone number, choose the Modem button.
When connecting over a NetWare network, the NetWare server name and participant's login ID are 
displayed, if you already have entered it.    To define or change the server name or login ID, choose the 
Network button.
When connecting over a NetBIOS network, the participant's NetBIOS address is displayed, if you already 
have entered it.    To define or change the NetBIOS address, choose the Network button.    Note that the 
case is significant in a NetBIOS address.

When connecting over a TCP/IP network, the participant's TCP/IP address is displayed.    To define or 
change the TCP/IP address, choose the Network button.    Note that the case is significant in a TCP/IP 
address.

To establish a connection using the Connect dialog box:

1. If you're connecting with someone for the first time, choose the Add Name button to open the Add 
Participant Name dialog box, and close the Add Participant Name dialog box when you're finished.

or

If you've connected with this person before, select the person's name from the Participant Name 
list.    You can type the first letter of the name to jump to that point alphabetically in the list.

2. If you're connecting with someone for the first time via modem, choose the Modem button to open 
Modem Connection Details dialog box, and close the Modem Details dialog box when you're 
finished.

or

If you're connecting with someone for the first time via network, choose the Network button to open 



Network Connection Details dialog box, and close the Network Details dialog box when you're 
finished.

or

If you've connected with this person before, verify the connection details.

3. Choose the Connect button to make the connection and start the conference.

To change a name in the list:

· Select the name and then choose the Edit Name button to open the Edit Participant Name dialog 
box.

To remove a name from the list:

· Select the name and then choose the Remove Name button.

____________
See also

Connecting to another participant and start a conference

Using special conferencing features





Participant Name list (Connect dialog box)

Select the name of the person with whom you are connecting.    To add someone to the list, choose the 
Add Name button.    To connect to someone on the list but using a different method, choose the Modem 
or Network button to define the new connection information.



Connect Using Modem information (Connect dialog box for modems)

The modem phone number is displayed, if defined.    To define or change the modem phone number, 
choose the Modem button.

(When connecting over a network, the address is displayed, if defined.    To define or change the 
network information, choose the Network button.)



Connection Details buttons (Connect dialog box)

Choose the Modem button to define or change the modem phone number and baud rate for connecting 
to the selected person.

Choose the Network button to define or change the network (NetWare, NetBIOS, or TCP/IP) address 
for connecting to the selected person.    Note that the case is significant in a NetBIOS or TCP/IP 
address.



Connect button (Connect dialog box)

Choose the Connect button to make the connection and start the conference.







Add, Edit, Remove Name buttons (Connect dialog box)

Choose the Add button to add a new name to the Participant Name list, which is actually a view into the 
Address Book.    (Names do not have to be unique.)    Choose Edit to change the spelling of a name.    
Choose Remove to delete the current name and all its connection information.    Over 5000 names can 
be stored in the Address Book.

The default Address Book file is PROSHARE.ABF (in your WINDOWS\ICOMM\ADDRBK directory), but 
you can change the filename in the PSDATA.INI file:

[PSDATA User Info]
AddressBookFile=PROSHARE.ABF

You can create as many Address Book .ABF files as you want.





 Add Participant Name dialog box

The Add Participant Name dialog box opens when you choose the Add Name button in the Connect 
dialog box.    Use this dialog box to define a new participant name for the Connect dialog box.

Click on an area for information.

To add a name:

1. Enter the participant's first and last names.    Names do not have to be unique.

2. Choose OK.



Name fields (Add Participant Name dialog box)

Enter the first and last name in the text entry fields.



 Edit Participant Name dialog box

The Edit Participant Name dialog box opens when you choose the Edit Name button in the Connect 
dialog box.    Use this dialog box to modify the currently selected participant name in the Connect dialog 
box.

Click on an area for information.

To edit a name:

1. Edit the spelling of the participant's first and last names.    Names do not have to be unique.

2. Choose OK.



Name fields (Edit Participant Name dialog box)

Edit the first and/or last name in the text entry fields.



 Network Connection Details dialog box

The Network Connection Details dialog box opens when you choose the Network button in the Connect 
dialog box.    Use this dialog box to define network connection information for the currently selected 
participant in the Connect dialog box.

Click on an area for information.

To define network connection information for the participant:

1. From the Connect Using list, select NetWare, NetBIOS, or TCP/IP for the network type.

2. For a NetWare connection, choose the Search button and select the server and name of the person 
with whom you want to connect.    The network address is automatically entered.

or

For a NetBIOS or TCP/IP connection, you must enter the network address.    Note that the case is 
significant in a NetBIOS or TCP/IP address.

Note that if you cannot determine the other participant's network information, the information is 
listed in his or her Conference Setup dialog box.    Have the other participant start the ProShare 
application and from the Conference menu, choose the Setup command.    Then the other 
participant can read you the information over the phone.    Enter the network address (you do not 
have to fill in the login ID or the server name) in the Network Connection Details dialog box.

3. Choose OK.



Connect Using list (Network Connection Details dialog box)

Select NetWare, NetBIOS, or TCP/IP for the network type.



Network address (Network Connection Details dialog box)

For a NetWare connection, if you fill in the participant's login ID, the ProShare application will attempt to 
fill in the server name and network address.    Or choose Search and select the server and name of the 
person with whom you want to connect.

The network address is the critical connection information (you do not have to fill in the login ID or the 
server name).

For a NetBIOS or TCP/IP connection, fill in the participant's network address.    Note that the case is 
significant in a NetBIOS or TCP/IP address.



Network connection information (Network Connection Details dialog box)

Note that if you cannot determine the other participant's network information, the information is listed in 
his or her Conference Setup dialog box.    Have the other participant start the ProShare application and 
from the Conference menu, choose Setup.    Then the other participant can read you the information 
over the phone.



Search button (Network Connection Details dialog box)

For a NetWare connection, choose the Search button and select the server and name of the person 
with whom you want to connect.    The network address is automatically entered.







 Modem Connection Details dialog box

The Modem Connection Details dialog box opens when you choose the Modem button in the Connect 
dialog box.    Use this dialog box to define modem connection information for the currently selected 
participant in the Connect dialog box.

Click on an area for information.

To define modem connection information for the participant:

1. Verify that the COM port shown is correct for your modem.    To change the COM port, cancel out of 
this dialog box and the Connect dialog box.    Then from the Conference menu, choose the Setup 
command and choose the Set Modem button to display the Set Modem dialog box.    Re-enter the 
Modem Connection Details dialog box.

2. Enter the modem phone number of the person to whom you're connecting.    The ProShare 
application automatically includes modem initialization strings.    You can use hyphens or spaces as 
separators, for example, 9-1-503-555-1212.    If you need a pause between numbers as they are 
being dialed, insert a comma between numbers, for example, 9,1-503-555-1212.

Within the U.S. and Canada, if you are using the Smart Dial feature of Address Book (disabled by 
default), do not enter a long distance access code or any other numbers you need to access an 
outside line.    The Smart Dial feature automatically includes these numbers based on your location 
when the call is made.

Outside the U.S. and Canada and dialing a number in another country, if you are using the Smart 
Dial feature of Address Book (disabled by default), do not enter a long distance access code or any 
other numbers you need to access an outside line.    The Smart Dial feature automatically includes 
these numbers based on your location when the call is made.    (When dialing a number within your 
country, always include any required prefix dial codes, such as 9 for an outside line or 1 for long 
distance, and so on.)

3. Select the Connection Baud Rate for this connection.    Note that any change to the baud rate 
setting is not retained after this connection.

Note that if you are using a custom, high-speed driver with your modem (baud rates up to 115200) 
and your baud rate is not available in this dialog box, you need to select the Use High Speed Baud 
Rates check box in the Set Modem dialog box (Conference menu, Setup command, Set Modem 
button).

4. Choose OK.





Modem Phone Number edit box (Modem Connection Details dialog box)

Enter the modem phone number of the person to whom you're connecting.    Include any required prefix 
dial codes, such as 9 for an outside line or 1 for long distance, and so on.    You can use hyphens or 
spaces as separators, for example, 9-1-503-555-1212.    The ProShare application automatically 
includes modem initialization strings.    If you need a pause between numbers as they are being dialed, 
insert a comma between numbers, for example, 9,1-503-555-1212.



Connection Baud Rate list (Modem Connection Details dialog box)

Select the Connection Baud Rate for this connection.    Note that any change to the baud rate setting is 
not retained after this connection.

Note that if you are using a custom, high-speed driver with your modem (baud rates up to 115200) and 
your baud rate is not available in this dialog box, you need to select the Use High Speed Baud Rates 
check box in the Set Modem dialog box (Conference menu, Setup command, Set Modem button).



 NetWare Search dialog box

The NetWare Search dialog box opens when you choose the Search button in the Connect dialog box. 
Use this dialog box to select from a list of NetWare users on your network.

Click on an area for information.

To locate and select a NetWare user:

1. Select a server from the Server list.    By default, the Server list contains the servers to which you're 
logged in.    Select the Show All Servers check box to list all servers "visible" from your network 
connection.

2. Select a NetWare user from the User Name list.    The user's network address is automatically 
displayed below.    (Note that some servers do not make available the names of connected users; 
each network administrator decides whether to provide this information.)

3. Choose OK.

If you cannot find the NetWare user:

1. Call the user and ask him or her to start the ProShare application.

2. Ask the user to choose the Setup command from the Conference menu to open the Conference 
Setup dialog box.

3. Request the user to recite the network address information that displays.

4. Enter the network address (you do not have to fill in the login ID or the server name) in the Network 
Connection Details dialog box.



Server list (NetWare Search dialog box)

Select a file server from this list.



User Name list (NetWare Search dialog box)

Select a NetWare user.    Note that some servers do not make available the names of connected users; 
each network administrator decides whether to provide this information.



Net Address field (NetWare Search dialog box)

Displays the network address of the selected user.



Show All Servers check box (NetWare Search dialog box)

Check this box to display in the Server list all servers "visible" from your network connection.



 Conference Setup dialog box

The Conference Setup dialog box opens when you choose the Setup command from the Conference 
menu.    Use this dialog box to set the types of conference connections you want your ProShare 
application to accept.    (The settings in this dialog box do not affect your ability to initiate a connection, 
but settings displayed by the Set Modem button do affect your ability to initiate modem connections.)

Click on an area for information.

To accept conference connections via modem and to check or change your modem settings:

1. Select the Modem check box.    (The check box is unavailable if you do not have a modem or your 
modem is not on.)

2. To change the settings that your modem uses for both incoming and outgoing conference 
connections, choose the Set Modem button to open the Set Modem dialog box, and close the Set 
Modem dialog box when you're finished.

3. The ProShare application saves any changes by default.    To make these changes apply to this 
conferencing session only, deselect the Permanent Changes check box.

4. Choose OK.

To accept conference connections via network:

1. Select the NetWare, NetBIOS, or TCP/IP Network check boxes, or any combination.    (The check 
boxes are unavailable if you do not have the appropriate network software loaded and running.)

2. The ProShare application saves the check box state by default.    To keep the check box state for 
this conferencing session only, deselect the Permanent Changes check box.

3. Choose OK.

____________
See also



Setting your connection preferences for incoming connections

Using special conferencing features



Modem check box (Conference Setup dialog box)

Select Modem to accept conference connections by modem.    Choose the Set Modem button to display 
the Set Modem dialog box so you can check or change your modem settings.



NetWare Network check box (Conference Setup dialog box)

Select NetWare Network to accept conference connections across a NetWare network.    Your own 
network server and address are displayed for reference.



NetBIOS Network check box (Conference Setup dialog box)

Select NetBIOS to accept conference connections across a NetBIOS network.    Your own network 
address information is displayed for reference.



TCP/IP Network check box (Conference Setup dialog box)

Select TCP/IP to accept conference connections across a TCP/IP network.    Your own network address 
information is displayed for reference.



Set Modem button (Conference Setup dialog box)

Opens the Set Modem dialog box for checking or changing your modem settings as used during both 
incoming and outgoing conference connection.



Permanent Changes check box (Conference Setup dialog box)

The ProShare application saves any changes to your connection preferences by default.    To change 
preferences for this conferencing session only, deselect the Permanent Changes check box.



 Set Modem dialog box

The Set Modem dialog box opens when you choose the Set Modem button in the Conference Setup 
dialog box.    Use this dialog box to set the modem type, baud rate, port, and modem strings for 
incoming and outgoing connections.

Click on an area for information.

To set up your modem:

1. From the Modem Type list, select your modem type or a type compatible with your modem.    The 
modem strings for Initialize, Dial, and Answer are set to defaults when you select a modem type.    If 
you don't know your modem type (or your modem does not appear in this list), select Hayes 
compatible.    If you are directly connecting two systems together using a cable between the serial 
ports, select Direct Connect - No Modem.    (See direct-connect cable requirements below.)

2. From the Baud Rate list, select the highest baud rate that your modem supports for data transfer, 
unless you are lowering the baud rate for compatibility reasons.    (Note that if you specify a 14.4 
Kbps modem, a message appears indicating 19.2 Kbps will be used.    The ProShare application 
always increases 14.4 Kbps to 19.2 Kbps, which is the maximum that Windows supports).

3. From the Port buttons, select the COM port to which your modem is attached.    If you do not know 
the port number, try COM1 or COM2 first.    If you have a "dedicated" mouse port (a special port 
other than one of the COM ports), the modem is probably connected to COM1.    If your mouse 
uses a COM port, the modem is probably connected to COM2.

4. If you are accessing a modem or modem pool connected through a network, select the Use Int14 
check box.    Note that the maximum throughput of an Int14 communicating over DOS and Windows 
is approximately 9600 bits per second.

5. If you are using a custom, high-speed driver with your modem (baud rates up to 115200), select the 



Use High Speed Baud Rates check box, and then from the Baud Rate list, re-select the baud rate 
to use.    Note that selecting the Use High Speed Baud Rates check box also affects the baud rates 
available in the Modem Connection Details dialog box (Conference menu, Connect command, 
Modem button).

6. Unless you are going to customize strings in step #8, from the Dial Using buttons, select whether to 
use tone or pulse dialing.    (If you customize strings, enter your own codes for tone or pulse in the 
command strings.)

7. Unless you are going to customize strings in step #8, from the Modem Sound buttons, select 
whether to have the modem produce sound (Speaker On) or not (Speaker Off).    (If you customize 
strings, enter your own codes for sound off or sound on in the command strings.)

8. The modem command strings for Initialize, Dial, and Answer are set to defaults when you select a 
modem type.    To change the defaults, select the Customize Modem Strings check box.    Then 
enter the command strings for Initialize, Dial, and Answer.    See descriptions of the correct modem 
settings below.    Note that selecting Customize Modem Strings disables the Dial Using and Modem 
Sound buttons.

9. The ProShare application saves any changes by default.    To make these changes apply to this 
conferencing session only, deselect the Permanent Changes check box.

____________
Important tips

If you use the Customize Modem Strings feature, only enter changes for one modem from the Modem 
Type list while the dialog box is open.    To customize another modem, enter the dialog box a second 
time.

The ProShare application saves any changes to modem strings by default.    (To make these changes 
apply to this conferencing session only, deselect the Permanent Changes check box.)    By leaving the 
Permanent Changes check box selected, the next time you execute the ProShare application, those 
strings are the default for that modem.    To save a custom string setup without changing a modem in 
the list, enter a unique name for your modem in the Modem Type list before saving the changes.    
(Place the cursor in the Modem Type box and type in your new name.    Do not select another Modem 
Type from the existing list before exiting the dialog box--you will lose any new customized strings you 
may have entered.)

If you deselect the Customize Modem Strings check box and you haven't exited the dialog box, any 
custom strings you may have input are lost.

Customized modem strings are saved in the PSDATA.INI file in your Windows subdirectory.    Default 
modem strings (those that ship with the ProShare software) are in the PSMODEMS.INI file, also in your 
Windows subdirectory.    You can delete the custom settings in the PSDATA.INI file to revert to the 
default settings in the PSMODEMS.INI.

Direct-connect cable requirements:

Side A Side B

25-pin 9-pin 9-pin 25-pin
2 (3) <-----> (2) 3 TxD
3 (2) <-----> (3) 2 RxD
4 (7) <-----> (8) 5 RTS
5 (8) <-----> (7) 4 CTS
6 (6) <-----> (4) 20 DSR
7 (5) <-----> (5) 7 GND

20 (4) <-----> (6) 6 DTR

Correct modem settings:

Check your modem documentation for information on the following settings:

· Assert Carrier-Detect when modem detects carrier signal (often the &C1 command).



· Bidirectional RTS/CTS flow control (often \Q3 or &K3 command).

· Use verbal result code (non-numeric, often the X4, Q0, and V1 commands).

· Modem hangs up on on-to-off transition of DTR (often the &D2 command).

· Always assert DSR (often the &S0 command).

· Additional commands can be used to disable certain advanced modem features such as 
asynchronous operation, compression, or error control (such as &Q0 or \N0).



Modem Type list (Set Modem dialog box)

Select your modem from this list.    If you don't know your modem type (or your modem does not appear 
in this list), select Hayes compatible.



Baud Rate list (Set Modem dialog box)

Select the baud rate from the drop-down list, unless you are lowering the baud rate for compatibility 
reasons



Port buttons (Set Modem dialog box)

Select the COM port to which your modem is attached.



Use Int14 check box (Set Modem dialog box)

If you are using a modem pool (modems attached to a server and not directly to your machine), you can 
select this check box.    Note that the maximum throughput of an Int14 communicating over DOS and 
Windows is approximately 9600 bits per second.    Check your modem documentation for performance 
considerations.



Use High Speed Baud Rates check box (Set Modem dialog box)

If you are using a custom, high-speed driver with your modem, select the Use High Speed Baud Rates 
check box, and then from the Baud Rate list, re-select the baud rate to use.



Dial Using buttons (Set Modem dialog box)

Select whether to use tone or pulse dialing.



Modem Sound buttons (Set Modem dialog box)

Select whether to have the modem produce sound (Speaker On) or not (Speaker Off).



Modem Strings settings (Set Modem dialog box)

The modem command strings for Initialize, Dial, and Answer are set to defaults when you select a 
modem type.    To change the defaults, select the Customize Modem Strings check box.    Then enter 
the command strings for Initialize, Dial, and Answer.    See your modem documentation for what values 
to use.

____________
Important tip

Once you customize strings for a modem and then choose OK to exit the dialog box, the strings are 
permanently changed for that modem.    The next time you execute the ProShare application, those 
strings are the default for that modem.    To save a custom string setup without changing a modem in 
the list, enter a unique name for your modem in the Modem Type list before saving the changes.    
(Place the cursor in the Modem Type box and type in your new name.    Do not select another Modem 
Type from the existing list before exiting the dialog box--you will lose any new customized strings you 
may have entered.)

If you deselect the Customize Modem Strings check box and you haven't exited the dialog box, any 
custom strings you may have input are lost.



Permanent Changes check box (Set Modem dialog box)

Leave this check box selected if you want to permanently save any changes you have made.    If you 
deselect the check box, the changes are effective only for the current conferencing session.



 Jump Start dialog box

The Jump Start dialog box opens when you choose the Jump Start command from the Conference 
menu.    The text that appears in this dialog box helps you send via modem a limited Jump Start version 
of the ProShare application to someone who does not have the ProShare software.    Once that person 
receives the Jump Start version, he or she unpacks it into a subdirectory and executes the Jump Start 
program under Windows.    Then you can establish a conference via network or modem.

In the dialog box, choose the Continue button to go to the next instruction; choose Back to return to the 
previous instruction.

Transferring over a network

Although the Jump Start dialog box contains instructions for transferring over a modem, you can also 
transfer the Jump Start version of the ProShare Personal Conferencing application over a network, 
either by electronic mail or by copying the PSJUMP.EXE file to a server or bulletin board accessible to 
your colleague.    The PSJUMP.EXE file is located in your ProShare software directory.    Once your 
colleague has the file, follow the directions in the section below, Install the Jump Start version of the 
ProShare application on the receiving computer.

Transferring over a modem

The first several dialog boxes summarize the Jump Start process and instruct you on using the Jump 
Start dialog box.    At the end of the summary, you are prompted to enter your colleague's name and 
modem phone number.    Just enter your colleague's first name.    For the number, enter all digits that 
must be dialed including prefixes and area codes.    You can use hyphens to separate the fields.    If you 
need a pause between numbers as they are being dialed, insert a comma between numbers.    Be sure 
that the number you enter is your colleague's modem phone number and not a voice line.

Create destination directory

Tell your colleague to create a directory for the Jump Start version of the ProShare application.    Your 
colleague will need about 2 megabytes of disk space for the Jump Start version.    The suggested 
directory name is PSJUMP.    Then if your colleague eventually purchases and installs the retail version 
of the ProShare application, the directories will not have the same name.

Communications setup

The communications setup dialog boxes describe how to establish a connection using the Windows 
Terminal program on your colleague's computer.    The Windows Terminal program is usually installed in 
the Program Manager's group named Accessories.    The program's icon is labeled Terminal:

If your colleague cannot find the icon to run the program, try these alternatives:

· Use the File Run command in the Windows Program Manager, and enter the following on the 
command line:

terminal.exe

The Windows Terminal program should be installed in your Windows directory, so if you want to 



specify a drive and path, enter the drive and path of your Windows directory.

· Use the Windows File Manager.    Find the file TERMINAL.EXE and double-click it.    This file is 
usually in your Windows directory.    If it is not there, use the File Search command in the File 
Manager to find it.

· Create a program icon for the Windows Terminal program using the Windows Program Manager 
File New command.    Choose Program Item to open the Program Item Properties dialog box and 
specify the label and command line for TERMINAL.EXE.

· If the TERMINAL.EXE file does not exist on your colleague's hard drive, he or she can install the 
Terminal program from the Windows installation disks.    Consult the Windows documentation for 
instructions on installing a component of Windows.

· Use an alternate modem communications software program.

Once the Windows Terminal program is running, it must be configured.    The Jump Start dialog boxes 
describe how your colleague should configure the Terminal program so you can transfer the Jump Start 
file.    One terminal setting requires a COM port name; this is the port on the computer to which the 
modem is connected.    If your colleague does not know the setting, try COM1 or COM2 first.    If he or 
she has a "dedicated" mouse port (a special port other than one of the COM ports), the modem is 
probably connected to COM1.    If the mouse uses a COM port, then the modem is probably connected 
to COM2.

Using an alternate modem communications software program

The Jump Start dialog assumes that the colleague to whom you are sending Jump Start will use the 
Windows Terminal communcations software to establish a connection and receive the Jump Start files. 
If your colleague wants to use another communications package, you may change the operation of the 
Jump Start dialog to accommodate this package.    Should you have a problem with the other 
communcations package, you can back up and change your selection to the Windows Terminal default 
at any time up until a connection is made.

Using different communications software allows the following changes from the default Windows 
Terminal method:

Your colleague can initiate the call rather than you initiate the call as in the default Windows 
Terminal method.

A selection of file transfer protocols is available to support other communications software.    The 
default Windows Terminal method uses the Xmodem file transfer protocol.    If you select another 
communications package, the Ymodem, Zmodem, and Kermit file transfer protocols also may be 
available for selection.

To use another communication package:

1. In the Jump Start dialog box, select Settings when it appears along with the Communications Setup 
screen.

2. Specify the settings for the remote communications software.    If the Windows Terminal option is 
selected, the other settings are disabled and reset to the default for Windows Terminal.    Selecting 
Continue at this point causes the Jump Start dialog box to behave as if you had not selected 
Settings.    If you select the Other Communications Program, you can also specifiy the file transfer 
protocol and whether you will initiate or receive the call.

3. Select Continue after selecting settings for another communications software package. This step 
causes the Jump Start dialog box to follow a different path to accommodate your selections.    For 
example, if your colleague is to initiate the call, you will be instructed to inform your colleague when 
to dial and then to select Continue only after you hear the modem phone line ring.    The Jump Start 
dialog box will also remind you to inform your colleague as to what file transfer protocol to use.



If you run into problems trying to transfer the Jump Start files using another communications software 
package and different file transfer protocol, do the following:

Change the file transfer protocol selection and other modem settings such as baud rate.    Baud rate 
can be changed in the Set Modem dialog box.

Use the default Windows Terminal which provides step-by-step instructions for communications 
setup and file transfer. 

Establish the connection

After the Terminal program is configured on your colleague's computer, you can establish a connection. 
The modem commands that your colleague enters (ATZ and ATS0=1) work for most modems but they 
may not work in all cases.

After the connection is established, you can transfer the Jump Start file.

If the connection fails:

· If you are dialing your colleague, have your colleague enter the following modem command string 
instead of ATS0=1:
ATS0=1 \N0

or

If your colleague is dialing you, have your colleague enter a command similar to the following:
AT \N0 DT number

· If adding \N0 to the modem command string that your colleague is entering still fails, you can add 
\N0 to your modem's initialization string by canceling out of the Jump Start dialog sequence and 
changing your modem setup:

From the Conference menu, choose the Setup command.    Choose the Set Modem button.    Select 
the Customize Modem Strings check box.    Append the \N0 command to the string displayed in the 
Initialize text box.    Deselect the Permanent Changes check box only if you want these changes to 
apply to this session without affecting future sessions.    Choose OK.

From the Conference menu, choose the Jump Start command.    Follow the sequence of dialogs 
back to this point in the process.

· If you still have problems, ensure that both you and your colleague have specified the same baud 
rate.    To verify or change your baud rate:

From the Conference menu, choose the Setup command.    Choose the Set Modem button.    Verify 
the rate displayed in the Baud Rate list and change it to match your colleague's, if necessary.    
Deselect the Permanent Changes check box only if you want these changes to apply to this 
session without affecting future sessions.    Choose OK.

From the Conference menu, choose the Jump Start command.    Follow the sequence of dialogs 
back to this point in the process.

Transfer the Jump Start file

Once the connection between computers is established, you can transfer the Jump Start file 
PSJUMP.EXE.    Your colleague must specify the directory created earlier (for example, PSJUMP) and 
the filename PSJUMP.EXE to receive this file.    The file transfer can take about 20 minutes to complete. 
When it is done, you and your colleague can exit from the Windows Terminal program.

If the transfer fails:

· If you are dialing your colleague, have your colleague enter the following modem command string 
instead of ATS0=1:



ATS0=1 \N0

or

If your colleague is dialing you, have your colleague enter a command similar to the following:
AT \N0 DT number

· If adding \N0 to the modem command string that your colleague is entering still fails, you can add 
\N0 to your modem's initialization string by canceling out of the Jump Start dialog sequence and 
changing your modem setup:

From the Conference menu, choose the Setup command.    Choose the Set Modem button.    Select 
the Customize Modem Strings check box.    Append the \N0 command to the string displayed in the 
Initialize text box.    Deselect the Permanent Changes check box only if you want these changes to 
apply to this session without affecting future sessions.    Choose OK.

From the Conference menu, choose the Jump Start command.    Follow the sequence of dialogs 
back to this point in the process.

· If you still have problems, try selecting a different file transfer protocol or try using different baud 
rates.

Install the Jump Start version of the ProShare application on the receiving 
computer

The PSJUMP.EXE file is a self-extracting, compressed library.    It contains several Jump Start 
application files.    Instruct your colleague to run PSJUMP.EXE using the File Run command in the 
Windows Program Manager; the library decompresses all the separate application files into the same 
directory.

A license agreement appears before decompressing the files, and your colleague needs to confirm the 
agreement by selecting Yes to install the Jump Start files.

After the files are decompressed (less than a minute), your colleague can create a program icon for the 
ProShare application's Jump Start using the File New command in the Windows Program Manager.    
Specify the drive, the directory path, and the program name PSDATA.EXE.

Run the Jump Start version of the ProShare application on the receiving 
computer

Double-click the icon to run the Jump Start version of the ProShare application.    Or use the File Run 
command in the Windows Program Manager and specify the drive, directory, and path for 
PSDATA.EXE.

Conduct the conference

After your colleague is running the ProShare application's Jump Start, you can connect over the 
modem or a network, and conduct a conference.    Before establishing a connection, your colleague 
must configure the connection on the Jump Start version using the Setup command from the 
Conference menu, and configure the modem using the Set Modem button in the Conference Setup 
dialog box.

After you have both configured your connection settings, you can establish the connection with your 
colleague's computer by using the Connect command from the Conference menu.

____________
See also

Working with someone who doesn't have the ProShare application





 Share Application View dialog box

The Share Application View dialog box opens when you choose the Share Application View command 
from the Application menu or the Share Application tool in the floating Data Capture toolbox.    Use this 
dialog box to select the application to share with the other participant.    Select the application from the 
list and then choose OK. 

____________
Note

Only currently running, Windows-based applications appear in the Share Application View dialog box.    
You can share multiple applications by selecting an application, then choosing the Share Application 
tool or the Share Application View command again.

Click on an area for information.

To share an application:

1. From the Application list, select the application.

2. Choose OK.

____________
Important tip

When you begin application sharing, if the ProShare software detects differing keyboard drivers, the 
software displays a message suggesting that you execute in view-only mode.    Keyboard drivers, 
especially those that enable keyboards for different languages, can interpret keystrokes differently.    
Use the view-only tool to toggle between interactive and view-only modes.

____________
See also

Application sharing windows

Sharing an application



Application list

Shows a list of Windows-based applications that are running on your computer.    Select the application 
you want to share and then choose OK.

You can share multiple applications by selecting an application, then choosing the Share Application 
tool or the Share Application View command again.
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Address Book

The Address Book application is much like your personal address book.    To launch the Address Book 
from the ProShare application, from the Conference menu, choose the Address Book command.    You 
also can open the Address Book by double-clicking its icon in the ProShare program group.    Within 
Address Book, you can choose the person with whom you want to connect.    If you specify a name in 
the Connect dialog box, the ProShare application automatically searches the Address Book for a 
corresponding entry.





annotation

A mark on a notebook page, including the marks you make with any of the annotation tools.    You can 
place annotations on the page using the annotation tools or you can bring a file into your notebook 
using the File Open or File Import commands.    Every item you bring into your notebook is a copy of the 
original item.



Annotation toolbox

The Annotation toolbox contains marking tools and pointers for making marks and manipulating 
annotations in the notebook.    The lower six tools in the annotation toolbox can be any combination of 
highlighters, pens, circles, lines, rectangles, and text tools.    Double-click any of these tool buttons in 
the Annotation toolbox to configure the tool or change its characteristics.

Buttons in the Annotation toolbox correspond to actions that can also be performed through a Toolbox 
menu command.    The buttons bypass the commands and directly choose the action without opening 
the menu.





application sharing

A shared application works the same within the ProShare application as it does when run under 
Microsoft Windows.    However, when run as a shared application, both participants can interact with the 
application features and commands to create or revise the same data or object.





Attendee status bar

This bar at the top of the notebook shows the names of the participants attending the conference, plus 
the notebook page number that each participant is currently viewing.    Double-click the page number of 
the other participant in the Attendee status bar to jump to that page.



Bookcase

The Bookcase button in the Help window opens the Bookcase window, which displays an outline of all 
the major topics in the Help file and in other related Help files.    You use the Bookcase window to 
navigate through all the related Help systems, to search for text across any and all Help systems, and 
to print all the topics in any branch of an outline.



conference

A meeting in which two participants communicate over computers connected with a modem or a 
network.    In the conference, the participants work on-screen while simultaneously viewing, marking up, 
or updating information brought into the notebook.



configure

The process of changing the notebook modem and network settings, display settings, or annotation 
tools to suit your personal preferences.    For example, the View menu contains commands that you use 
to change the appearance of the ProShare application's notebook and status bars.    From the Toolbox 
menu, you choose the Configure Tool command to specify the color of the annotation tools that appear 
in the toolbox.    From the Conference menu, choose the Setup command to set connection 
preferences, such as modem settings.



connect

The process of establishing communications between your computer and your colleague's computer 
over a modem or a network.



crop tool

A tool in the Data Capture toolbox that you use to bring information into the ProShare application's 
notebook.    When you select the crop tool, you can take a snapshot of the region you define for 
insertion into a notebook page.    Use the crop tool to define a small region of a screen that you need.







Data Capture toolbox

A floating toolbox that you use to snapshot portions of data from another application for insertion into 
the notebook, sharing the information with the other conference participant.    You also can share one or 
more Windows-based applications with the other conference participant, whether or not the other 
participant has the same application installed.    The Data Capture toolbox floats on top of your screen.

____________
Tip

When you are not connected to another participant, on color monitors the start sharing and stop sharing 
buttons are gray to indicate that the actions are unavailable.    Shift+F1 context-sensitive Help is not 
available for the buttons when the action is unavailable.





ellipse tool

A tool in the Annotation toolbox that draws ellipses and circles.    To draw a circle, press and hold the 
Shift key as you click and drag the mouse.    Double-click the ellipse tool button in the Annotation 
toolbox to configure the tool or change its characteristics.



file transfer

The process of sending one or more files from your computer to your colleague's computer using the 
Transfer command from the File menu.





guest

The conference participant who views and optionally interacts with a shared application in a Sharing 
window.    The host controls the guest's interaction with the shared application with the view-only tool, or 
the Only Host Edits command from the Application menu in the ProShare notebook.





highlighter tool

A tool in the Annotation toolbox that lets you color over items in the notebook.    Double-click the 
highlighter tool button in the Annotation toolbox to configure the tool or change its characteristics.





host

The conference participant who launches and then shares an application.    The host controls the 
guest's interaction with the shared application with the view-only tool, or the Only Host Edits command 
from the Application menu in the ProShare notebook.





importing data

The process of bringing data from another application into the ProShare application's notebook using 
the Import command on the File menu.    Imported files can be of the following formats:

· Graphics files in a format that the ProShare application can read.    Importing a graphics file 
preserves the number of colors in the graphic.

· An entire file in another format.    Instead of taking several snapshots, you use the Import command 
to print the file contents into your notebook pages.    Graphics within such files are imported in a 
maximum of 16 colors.



Jump Start

The process of transferring a limited version of the ProShare application to a colleague who does not 
have the program.    After the colleague installs the software, you can conduct a conference with him or 
her, either over a modem or network.





keyboard driver

Keyboard drivers interpret your keystrokes and allow applications to display what you type.





line tool

A tool in the Annotation toolbox that draws straight lines in the notebook.    To make the line "snap to" 45 
degree increments, press and hold the Shift key as you click and drag the mouse.    Double-click the 
line tool button in the Annotation toolbox to configure the tool or change its characteristics.



meeting file

A file containing the notebook pages in the ProShare application's .MTG file format.    You can save the 
notebook to a meeting file and then open it later for a subsequent conference.

The information in the private workspace is automatically saved to a file with the same name as the 
meeting file, but with the .PRV extension.    The .PRV file opens automatically when you open its 
corresponding .MTG file.

Version 1.5 meeting files can be opened in version 1.6, which automatically converts the file to 1.6 
format.    Once saved, you cannot subsequently open the meeting file in version 1.5.



new page tab

Adds a new blank page to the notebook.    When the New page tab has scrolled out of view, click 
repeatedly on the tab down-arrow to reveal the New page tab.



notebook

The ProShare application's workspace is a set of tabbed pages, or a notebook.    Each page in the 
notebook has a numbered tab.    You can insert a snapshot of data from another application into a 
notebook page, or import files to the notebook pages.    You can add and delete pages to and from the 
notebook.



OLE

The Windows term "OLE" means Object Linking and Embedding.    Using shared OLE, you can insert 
data from another application into the ProShare application's notebook.    The inserted data retains an 
association with the application that created it.    When you double-click the shared OLE object in the 
ProShare application's notebook, the ProShare application opens the application that originally created 
the data so that you can update the information.    Embedded objects are available only from 
applications that support OLE.    Shared OLE objects can be opened and updated only if the participant 
doing the editing has the application installed.    Only one participant can open and update a shared 
OLE object at a time.



Page Sorter

A dialog box you can open in the ProShare application to show multiple pages of your notebook in a 
thumbnail format.    You can change the order of pages, print pages, and delete pages in the Page 
Sorter.    You can leave the Page Sorter open while you work in the ProShare application's notebook.





Pan window

A thumbnail view of the shared application that appears on the guest's screen when the host's screen is 
larger or has a higher video resolution than the guest's screen.    The guest can drag the thumbnail view 
within the Pan window to make other areas of the application visible.    The guest can minimize the Pan 
window, but cannot close it.





participant

A person who is connected to a ProShare application conference.



pen tool

A tool in the Annotation toolbox that lets you write in the notebook.    Double-click the pen tool button in 
the Annotation toolbox to configure the tool or change its characteristics.



print capture

The process of bringing data into the notebook from another application using the ProShare print 
capture driver.    Print capture is useful if you want to copy a page or pages of a document, but you 
cannot view the entire page on the screen to snapshot it.    Use print capture to print those pages.    You 
can use the print capture process in two ways:

· From the File menu, choose the Import command.    In the Import Using dialog box, specify the Print 
Capture method.

· Open your document, select the page or pages to print to the notebook, and print to the ProShare 
application print capture driver.



private workspace

The private workspace, when showing, appears below the public workspace.    If you place data into the 
private workspace (using the snapshot tool, making marks, pasting, or importing a file), the other 
participant cannot see that information.



public workspace

The public workspace is the top of the notebook page.    When you place data into the public workspace 
(using the snapshot tool, making marks, pasting, or importing a file), the other participant can see it.



rectangle tool

A tool in the Annotation toolbox that draws rectangles and squares on the notebook page.    To draw a 
square, press and hold the Shift key as you click and drag the mouse.    Double-click the rectangle tool 
button in the Annotation toolbox to configure the tool or change its characteristics.



remote pointer

A tool in the Annotation toolbox that changes your cursor into a pointer that the other participant can 
see.    (Be sure that you are both using different colored pointers.)    With the remote pointer, you can 
use your mouse to point to items on the notebook as you discuss them.    Double-click the remote 
pointer tool button in the Annotation toolbox to change its color.



return tool

A tool in the Data Capture toolbox that brings the ProShare application to the top of your screen.



selection pointer

A tool in the Annotation toolbox that selects objects displayed in the notebook so you can move, copy, 
resize, or delete them.





share application tool

A tool in the Data Capture toolbox that opens the Share Application View dialog box, in which you can 
choose an application to share.    The sharing mode graphic appears in the title bar of any shared 
applications.

____________
Tip

When you are not connected to another participant, on color monitors this button is gray to indicate the 
action is unavailable.    Shift+F1 context-sensitive Help is not available for the button when its action is 
unavailable.



Sharing window

The guest sees the shared application within the Sharing window, separate from the notebook window, 
on his or her computer.    The sharing mode graphic appears in the title bar of any shared applications 
within the Sharing window.





snapshot tool

A tool in the Data Capture toolbox that takes a picture of a window on your screen and inserts it into 
your ProShare application notebook.



spiral

The border on the left side of the notebook page.    You can turn the spiral on and off in the Preferences 
dialog box (View menu).



status bar

The gray bar at the bottom of the notebook window.    The status bar usually contains information on the 
page number of the current notebook page and other connection information.    When you click on a tool 
in the Annotation toolbox, the status bar displays a brief message about the tool.    When you open a 
menu and click and hold on a command, the status bar displays a brief message about the command.    
From the View menu, choose the Preferences command to open the Preferences dialog box, where 
you can toggle the status bar on and off.





stop sharing tool

A tool in the Data capture toolbox that stops sharing all applications (if more than one is being shared). 
The applications remain open on the host's machine until specifically closed.

____________
Tip

When you are not connected to another participant, on color monitors this button is gray to indicate the 
action is unavailable.    Shift+F1 context-sensitive Help is not available for the button when its action is 
unavailable.





tabs

The row of numbered pages on the right side of the notebook.    The tab of the current notebook page is 
indicated with a blue number on a white background.    Click on a tab to jump to its page.    Double-click 
a tab to synchronize pages with the other participant.



text tool

A tool in the Annotation toolbox that lets you type text at the location you click. Text does not wrap 
around, so press Enter at the end of a line.    Double-click the text tool button in the Annotation toolbox 
to configure the tool or change its characteristics.





view-only tool

A tool in the Data Capture toolbox that lets the host of a shared application toggle the sharing mode 
between view-only and interactive.    As the host of the shared application, you can control whether the 
guest can interact with the shared application or not by choosing this tool or the corresponding 
commands from the Application menu.





wildcard

Special character in a filename designation, as defined by DOS.    The asterisk (*) can represent a 
sequence of characters, and the question mark (?) can represent any single character.



Help on using Help

Help is easy to use.    There are five basic steps.

1. Go to the Help window while using the application.

2. Read text, and, if necessary, use scroll bars or PgDn to see more.

3. Click on hotspots for additional information.

4. Use the buttons located at the top of the Help window to navigate through the Help.

5. On the File menu, choose the Exit command to leave Help and return to the application.



Getting to the Help window from the application

You can get Help in several ways:

· On the Help menu, choose the Contents command to go to the main Help topic.

· On the Help menu, choose the Search command and search for Help on a topic.

· Press the F1 key to get Help related to what you are doing.

· Press the Shift+F1 key to turn your mouse cursor into the context sensitive Help cursor .    
Then, click on an item in the application to get related Help.

____________
Tip

Within the ProShare application, Shift+F1 context-sensitive Help is not available for the following 
interface elements:

· the main window's menu bar

· the control menu on the main window, on the floating Annotation toolbox, and on the Data Capture 
toolbox

· the title bar and the minimize button on the Data Capture toolbox



Hotspots

Hotspots can be in text or in a picture.    In text, sometimes called click text, the hotspots are a different 
color (usually green) and either dashed- or solid-underlined.

In both text and pictures, the mouse pointer changes to a pointing hand  when you go over a 
hotspot.

With either text or a picture hotspot, click on the hotspot to go to the related information.
Some hotspots show the related information in a pop-up window.    Click outside the pop-up window to 
close it.

Other hotspots move you to another Help topic.    Choose the Go Back button (at the top of the Help 
window) to return from the jump.

Choose one now to see the difference.    Dashed underlines are pop-up windows.    Solid underlines    
move you to a related screen. 



Button bar

Located at the top of the Help window, these buttons provide the most common navigation and search 
functions.

Move to the main Help topic.

Return to the last Help screen you saw.

Display a window listing the topics you've seen. (Choose any to return there).

Search for a string and then go to a topic containing the string.

In some sections the forward and backward arrows are activated.    Like pages in a 
section of a book, flip to preceding and following topics.

Go to an outline of the Help in the Bookcase window.



Dashed-underline pop-up Help

Right!    This is a pop-up Help topic.    Click outside this window to make the pop-up go away.



Solid-underline jumps

You clicked on a word or phrase identified by a solid underline and jumped to a new topic.    Your 
original topic is gone...but not for long.    See the Go Back button at the top of the Help window?    Click 
on that (or press the B key) to return to where you were.



Searching in Help

In the Search dialog box, type in the word or words that you want to find and click OK.    You get a 
Search Results dialog box.    From there, choose topics that you want to go to.    The Search Results 
dialog box remains on the screen so you can return to it and choose another topic without having to do 
the search again.    Choose Cancel to remove this dialog box.

You can use wildcard characters (*) when you type in the word or words that you want to find.    For 
example:

Bee*

This phrase finds all words that start with Bee.

You can use search operators like AND, OR, NOT, and NEAR when you type in the word or words that 
you want to find.    You can enter an operator in uppercase or lowercase:

AND connects topics finding all phrases connected by AND.    If a phrase does not appear in quotes, 
any space between words in the phrase is assumed to represent an implicit AND.    For 
example:

Bees love honey

This phrase finds any topic containing the three words "Bees," "love," and "Honey."    This is the 
same as specifying Bees AND love AND Honey.    However, when quotes are used, Viewer 
searches for the entire phrase. For example:

"Bees love honey"

This phrase finds any topic containing the phrase "Bees love Honey."

OR The OR operator selects topics containing either phrase connected by OR operators.    For 
example:

Bees OR honey

This query displays topics containing either the word "Bees" or the word "Honey."

NOT The NOT operator selects any topic that does contain the phrase preceding NOT, but doesn't 
contain the phrase following NOT.    For example:

Bees NOT Honey

This query finds topics containing the word "Bees" but not the word "Honey."

NEAR The NEAR operator selects any topic in which one phrase appears within a certain number of 
words of the second phrase.    The default value is 8 words.    For example:

Bees NEAR honey

This query finds any topic in which the word "Bees" appears within 8 words before or after the 
word "Honey."    To change the default value, choose the Options button in the Search dialog 
box and enter a new number in the NEAR Means Within box.    Words that are next to each 
other are within one word of each other.

You can choose the Hints button in the Search dialog box to get a reminder of these operators.

Searching in the Help window

In the Help window, you search the single Help file that you are currently viewing.    This Help file may 
be divided into groups that are listed in the Search dialog box.    If groups appear, you can restrict the 
search by checking the groups to be searched.

Searching in the Bookcase window



In the Bookcase window, you can search the Help file that you are currently viewing as well as any 
other Help file that is registered in your ICOMM.INI file.    The Help files appear in the main Search 
dialog box.    You can restrict the search by checking the files to be searched.



Bookcase window

In the Bookcase window, you see an outline of all the Help files, i.e., books, that are registered in 
ICOMM.INI.    You can expand and collapse items in the outline by double-clicking the titles with a book 
icon.    On titles that have a page icon, double-click to jump to the topic in the associated Help file.

You can print multiple topics using the Print button in the Bookcase window.    When you click the Print 
button, all topics that are subordinate to the currently highlighted topic are printed.

Searching works the same in the Bookcase window and the Help window, except that you can search 
across separate Help files from the Bookcase Search.    When you click the Search button, you get a 
Search dialog similar to the Search dialog in the Help window.




